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Welcome
A helpdesk system integrated seamlessly within your Microsoft Office Outlook, transforming it from a simple email client
to a fully-fledged service provider.
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This is an elaborate help documentation that will guide helpdesk managers and technicians alike how to install,
configure, and work with support cases in matter of minutes. Graphic illustration and screenshots of the
screen/forms are used with proper marking wherever they are required to drive down the point of the relevant
topic.
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1. Introduction
You have a business that you aim one day to grow and be profitable. If you are one-person support team and have fewer
customers, sure, you can provide resolution to their grievances by writing or speaking to them, without logging the details of
the customer and nor documenting the nature of the problem. However, what happens if you have a large customer base? Of
course, there will be multiple support staffs attending to high number of support requests. BUT…
•
•
•
•
•

How would each one of them remember who sent what and who needs what?
How would John know that Monica has already resolved this particular customer’s issue?
How would you prevent them from working on the same issue concurrently to avert duplicate effort?
What if Monica solved an issue virtually identical to a separate issue John is currently working on?
How would John know this issue has been already resolved, so he could use this information to reply to the
customer’s issue?

For strategic decisions and intelligence, senior managers would certainly like to know how many times this particular problem
come up for this particular product has. How long has this problem been an issue for them?
Why a helpdesk system?
It is said that success of a business is measured against the level of customer satisfaction on sales and services. In fact, the
higher the customer satisfaction is the repeated business it creates. This is one of the key reasons why successful enterprises
have a dedicated help-desk team or call centers to cater to the queries and grievances of their customer base. But what
makes a help-desk team productive and successful? Well for sure, choosing the right helpdesk system is the first step that can
make all the difference.
But how do you arrive to the decision of choosing a particular helpdesk system? Do you need a helpdesk database system that
works standalone within your local network? Or do you need a web based helpdesk to enable your scattered support
personnel to work on troubled tickets? Or do you require a helpdesk that make uses of your existing email infrastructure such
as Microsoft Outlook and Exchange?
But why in Microsoft Office Outlook?
Typically, an ideal helpdesk system should support the organizations’ internal logic and workflows, integrates easily and
leverage existing infrastructures, caters to the support technicians on the move, enables automation and processing based on
customizable rules and most importantly, should be easy to use with little or no training requirement. This is where a
helpdesk system based on email client such as Microsoft Outlook scores over other type of support systems. This is because in
most businesses, most support staffs use Outlook extensively – all day, every day for email communications, appointments,
contacts, tasks etc. As they have relied that heavily on Outlook, it is only natural for them to turn Outlook to a sort of a
ticketing system to support requests and calls from customers.
Moreover, as Outlook provides quick access to company’s contacts, address books, mailboxes and public folders stored on a
central Exchange server, it makes it much easier for support personals to track, collaborate and log support requests in
Outlook.
The problems with helpdesks based on Outlook
Microsoft Outlook is a great productivity office application, something more of an indispensable companion for many
businesses. However, Outlook itself is highly optimized for personal email exchange often falling short when it comes to
providing a complete history of an event over time. When an email has been forwarded on to another helpdesk team
member, the original owner loses insight into the progress. This has a serious implication, that is, in its original state, Outlook
simply lacks the automation, reporting, reminders, and workflow to manage a support ticket request, which is critical for
growing helpdesks looking to optimize and uniformly improve support staff/customer interactions.
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The Solution - Extending your Outlook
The Team Helpdesk System answers these limitations by integrating itself within the Outlook process (as an add-in) and
extending it as an ideal platform to collect, track and resolve trouble tickets while sharing this information with your entire
team, all with ease. It brings all of help desk functionalities and automation and tightly integrates with the easy workflow of
Outlook, thereby allowing users to work in the same way they do with emails. What you would get as an IT manager is high
rate of user acceptance, yet low cost of operation, training and maintenance.

Back to TOC

Team Helpdesk for Outlook & SharePoint
Team Helpdesk is an ITIL guided, issue tracking and ticketing system with integrated asset management that is available as an
add-on for Microsoft Outlook. It is the only comprehensive helpdesk system entirely integrated seamlessly within your
Microsoft Outlook, transforming it from a simple email client to a fully-fledged service provider. Using Microsoft Exchange and
SharePoint as repository for storing support cases, it provides support staffs with all the necessary tools to log, collaborate,
analyze and assist in the resolution of help desk issues. Various medium of communication supports automated messaging
and notification requiring no human inputs.
Apart from e-mail, the ability to send SMS and make phone calls directly from your Outlook extends the exchange of
information to a new level, thereby, making it possible to integrate customer relationship management (CRM) processes in
core help desk functionalities.
With inbuilt support for advanced statistics and varied reporting options, support managers can evaluate the performance of
the helpdesk and in-turn ensures timely decision making for improved service. Most of the Team Helpdesk functionalities in
Outlook are also available via a web browser through web access - perfect for remote support staffs. Furthermore, caller can
submit new support requests via a web form, login to caller web access to track and escalate support cases, check status, or
search through the knowledge base, all via a web browser for first level support.
To sum up, Team Helpdesk improves the efficiency of the help desk to enable faster response time and higher productivity for
your organization at lower operating costs. After all, the bottom line for your help desk team is for your end-users to receive
better and timely service.
Benefits for your organization:
Work on cases in your Outlook as if you would work on emails
Single enterprise-wide view of support cases, callers, problems and resolutions
Little or no training requirement on the part of your support technicians
Centralized data storage on Microsoft Exchanger (mailbox or public folder) - efficient platform for collaboration
Enable integration with Active Directory
Common point-of-call for your callers
Structured workflow for all helpdesk activity
Freeing up valuable human resources by automating cases logging, sending notifications etc.
Higher productivity and increased "up-time" for support staffs
Organized state of cases means faster tracking requests
Identify problem areas and increase helpdesk efficiency
"Do more with less" - affordable one-time fee with enterprise-wide license

Benefits for your customers:
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Always in communication loop via the power and ease of automated email/messaging
Inspires confidence to the help desk service
A knowledge base that a caller can search through for resolution to their query
Check on the progress or status of the case via web
Request support in a standardized way through email, phone calls or web form submission
Case get resolved in a timely manner and hence customer satisfaction
Helps in building trust and loyalty in your brand

Back to TOC

How It Works?
Team Helpdesk System consists of two separate installs – Managerial and Agent.
•

The Managerial install is for helpdesk administrator who would configure and maintain the Team Helpdesk folders, drop
down lists, templates, FAQs and other helpdesk settings.

•

The Agent install is for the technicians to enable them to work on support cases in Outlook with the configured Team
Helpdesk folders.

Each of this tool is installed on individual computer as an extension to Microsoft Outlook and only relies on Microsoft Outlook for
the front-end and your exchange server and a network database, as the back-ends.

Step 1. Manager creates a settings
database
After the managerial tool is installed,
helpdesk administrator will be given a choice
of database options where all the settings,
templates and other helpdesk data will be
stored centrally.
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Database options include Microsoft
Exchange, Microsoft Access, Microsoft
SharePoint, SQL Server, Microsoft Azure
(cloud SQL server).
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Step 2. Manager configures
helpdesk settings and drop downs
Helpdesk administrator defines drop-down
lists such as technicians, callers, problems,
assets, as well as emails and SMS templates,
predefined replies, messaging options, web
access etc. With these global settings,
manager can streamline the behavior on
how all technicians work on support cases in
Outlook.
Administrator can also set the manager addin to monitor any number of mailboxes and
email folders, for automatic processing of
incoming emails to support cases. This
process cuts the overhead of manually
generating support cases from emails, thus
diverting valuable human resources to
resolving the case.

Step 3: Manager maps helpdesk
fields from Outlook to SharePoint
The next step is for the helpdesk manager to
configure a SharePoint list to be used as for
storing copies of support cases that were
generated in the 'Ongoing Cases' subfolder
of Team Helpdesk in Outlook.
New fields in the SharePoint list can be
automatically created to match the data type
and title of the Outlook helpdesk fields.
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If the particular mapped field takes a dropdown list in Outlook such as Problem
Category, Problem Type, Status, Callers
Name etc., the same drop-down list values
would be available in the configured list
automatically. Over time, as manager make
changes to the drop-down lists in Outlook,
Team Helpdesk would automatically update
the values in SharePoint too.

Back to TOC

Step 4: Technician installs Agent
add-in
The Agent tool consists of an Outlook add-in
that has all the logic and functionalities of
the helpdesk application. Each technician of
the helpdesk who would work on support
cases needs to install the Team Helpdesk
Agent tool.
After a successful install, you will see that
additional menus, toolbars or ribbons are
added in the explorer and inspector windows
of Microsoft Outlook.
Note: Apart from the managerial tool, helpdesk
administrators also need to install the client tool if they have
to work on support cases themselves.

Step 5. Caller submits support
request via email, web form or
phone call
An end-user experiencing technical
challenges can self-service the answer to
their problem by accessing the web-based
knowledge base (through the Team Helpdesk
Customer Web Service site).
If a solution is not found, the end-user
requests for support by sending an email, by
making a phone call or simply, by filling a
web form. These support requests are then
logged and converted to cases in Outlook.
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Further details and drop-down lists (such as
the classification of problems the request
falls into) can then be set, by a supervisor or
manager.
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Step 6. Assign technicians to the
case
Typically, a manager or senior technician
assigns the best technicians to the case for
fulfillment of the service and speedy
resolution.
Furthermore, in the helpdesk settings,
administrator can link and associate
individual technician to a caller, or to a
problem type such that when a new support
request email is received, if there is a match
between technician and the caller (read as
sender), or if a problem type is found in the
email subject, the associated technician will
get assigned automatically to the case.

Assigned technicians then get notified through an automated email or SMS.
Optionally, the due date of the case is entered into the personal calendar of the
technicians' mailbox.

Step 7. Technicians collaborate to resolve the case
The assigned technician then proceeds to fulfill and resolve the case, either in Outlook or via Technician Web Access (TWA).
Helpdesk manager may enforce a Service Level Agreement (SLA), set due date and other deliverables on the particular case for
the assigned technicians, for quality check purposes. Further correspondence to the caller might follow (in the form of emails,
SMS, phone calls). All activities related to the case are logged and technician can fill time spent and assign additional technician if
needed. Relevant asset information and fixes related to the case can be accessed and tracked right from the case form itself.

Step 8. Caller follows-up via email
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The caller can reply back to email from the helpdesk and the response automatically triggers an escalation on that particular
support case. If a response from the caller on an existing case is received, the concerned technicians are notified automatically. If
the case has been resolved, Team Helpdesk automatically re-opens and marks it as an ongoing case.

Back to TOC

Alternatively, caller can also choose to escalate, withdraw, reopen or simply track the history of their support cases online by
logging into the Caller Web Access (CWA) website (that comes with Team Helpdesk).

Step 9. Technician closes case
after providing a resolution
Certain pre-defined Outlook views can be
used to track the progress of cases. Once
every parameter of the caller's request has
been fulfilled, a case be closed. The closed
case is then moved to the Resolved Cases
folder. At the same time, the caller gets
notified automatically on the closure of the
case.
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Step 10. Technician adds resolution to knowledge base

Back to TOC

A closed case can be a good source of future reference and technician can create a new knowledge base entry based on the case.
It is then available in the list of articles under the integrated knowledge base, categorized and sorted, ready for your technicians
to draw from when similar issues arise. Helpdesk administrator can publish these articles on to the Customer Web Service site for
providing first level support to potential support requests from end-users.

Step 11. Manager generates statistical and trend reports
To identify problem areas and increase helpdesk
efficiency, senior management runs the
statistical tool from time to time, collecting
valuable intelligence and trends and generating
meaningful reports.
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For day to day knowledge of the helpdesk, they
can generate summary reports to get appraisal
on the current happenings on the helpdesk and
track recent cases generated, worked, closed or
reopened.

Back to TOC

Step 12. Manager archives old cases to database or PST
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Over time, the Team Helpdesk folders (in Exchange) will be accumulated with support cases mostly resolved ones. Helpdesk
managers can either archive the old case items to a PST file or can export the case data to an external database such as Oracle,
SQL or Access. Archiving periodically keeps the exchange folder from getting too big and unwieldy, which could cause
Exchange/Microsoft Outlook performance to slow down.

Back to TOC

2. Requirements
Team Helpdesk is available right inside your Outlook unlike any other standalone application and web-based help desk software. It
can be easily deployed through an installer (manually or via a group policy object with MSI) across the entire organization.
Please make sure that your system meets the following requirements before installing Team Helpdesk for Outlook and SharePoint:
Windows Version

Windows Vista, 7, 8, 8.1, 10. Both 32-bit and 64-bit OS are supported.

Outlook Version

Outlook 2019, 2016, 2013, 2010, Outlook 2007. Team Helpdesk operates directly inside
the Microsoft Outlook application (using Microsoft's "COM add-in" technology). Outlook
Express is not supported.

Database

Microsoft Access, all versions and editions (including Express edition) of SQL Server are
supported including cloud services such as Amazon RDS and Microsoft Azure SQL.

.NET Framework
SharePoint

Microsoft .NET Framework 4.5 or Higher.
SharePoint 2010 or Higher. Cloud based SharePoint such as Office 365 are also supported.
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.
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3. Installation
Team Helpdesk System consists of two separate installs – Managerial and Agent. The managerial install is for helpdesk
administrators who would configure and maintain the Team Helpdesk folders, drop down lists, templates, FAQs and other helpdesk
settings. Whereas, the Agent install is for the technicians to enable them to work on support cases in Outlook with the configured
Team Helpdesk folders.
Note: If administrators need to work on support cases, then the agent tool also needs to be installed, apart from the managerial
portion
Download link: SETUPS
There are two different setup types:
For 'Per User Installation' (ideal for standalone single user/workstation)
TeamHelpdeskSPSetups_x86.zip (for 32-bit Outlook 2007, 2010, 2013, 2016, 2019)
TeamHelpdeskSPSetups_x64.zip (for 64-bit Outlook 2010, 2013, 2016, 2019)
For 'Per Machine Installation' (ideal for installing on Citrix and Terminal Servers)
TeamHelpdeskSPSetups_x86_Citrix.zip (for 32-bit Outlook 2007, 2010, 2013, 2016, 2019)
TeamHelpdeskSPSetups_x64_Citrix.zip (for 64-bit Outlook 2010, 2013, 2016,2019)
The downloaded zip file contains 3 files: TeamHelpdeskSPManagerSetup_xXX.exe, TeamHelpdeskSPAgentSetup_xXX.exe and
VersionInfo.txt where ‘xXX’ can be either x86 (32-bit Outlook) or x64 (64-bit Outlook)
Extract these file contents to a file folder. It is recommended that you place the setup files on a shared network folder, such that all
users can have access to it, and ease the installation and upgrade process.
Per User Installation and Per Machine Installation
In Per User Installation, both the Manager and Agent installs are performed 100% on the local system and nothing is installed on
your Exchange or Windows Server. Further, this install is intended to serve only the current logged on user of the
system/workstation and will be installed under the user's application data folder (instead of Programs Files folder) and no elevated
permission is required (This is known as per user installation). So, there won't be a prompt from UAC to allow this install unless you
change the install directory to say, Programs Files which will warrant an elevated permission/UAC prompt. If the same system is
used by multiple technicians, each user needs to install Team Helpdesk add-in on their profile with the default installation folder
location.
Per Machine Installation: If you have the need to have a single install that serves all users of the system (i.e., per machine
installation, which technically means the files will be installed under Program files folder and the add-in will be registered under
HKEY_LOCAL_MACHINE registry hive rather than HKEY_CURRENT_USER), download the Citrix/Terminal Server version of the
setups to perform a per machine installation.

The Admin setup is of two different types - one each for 32-bit Outlook and 64-bit Outlook
For Per User Installation:
TeamHelpdeskSPManagerSetup_x86.exe (for 32-bit Outlook 2010, 2013, 2016, 2019)
TeamHelpdeskSPManagerSetup_x64.exe (for 64-bit Outlook 2010, 2013, 2016, 2019)
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For Per Machine Installation:
TeamHelpdeskSPManagerSetup_x86_Citrix.exe (for 32-bit Outlook 2010, 2013, 2016, 2019)
TeamHelpdeskSPManagerSetup_x64_Citrix.exe (for 64-bit Outlook 2010, 2013, 2016, 2019)

Back to TOC

Managerial Installation
The managerial installation consists of server tools and files, for creating the Team Helpdesk Outlook folders, and for
configuring and maintaining the settings of the helpdesk. It has to be performed by the helpdesk administrator/manager
before the client tool is installed on every technician's system.
Step 1. Run the TeamHelpdeskSPManagerSetup_xXX.exe to start the installation. Click 'Next' to Continue. If Outlook 2010 or
later is not installed, the setup wizard will not be able to proceed. Please also ensure Outlook is shutdown (if already running
or active in the task manager) as the setup has to install an Outlook add-in.

Page

15

Step 2. Select the appropriate destination folder where the application files will be installed. If you change the default folder
path, please make sure you have appropriate permission. (Note: by default, it will be installed under your application data
folder)

Back to TOC

Step 3. Click 'Next' to continue with the files extraction. It just takes a few minutes to complete the whole copying process
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Step 4. Click 'Finish’. This ends the files installation process in your system. Now start Microsoft Outlook

Back to TOC

Step 5. Start Outlook (restart if it was already running during the files installation). As soon as Outlook is loaded, you will be
prompted with the following dialog box, offering you two choices:

Create New Team Helpdesk folders – Click this button to create new Team Helpdesk folders (i.e., Ongoing Cases,
Resolved Cases, KB, Schedules, History and Settings) which are customized with Team Helpdesk specific fields, views
and forms. Follow step 6 to further go ahead with the configuration.
Use Existing Team Helpdesk folders – Click this button to use existing Team Helpdesk folders (i.e., Ongoing Cases,
Resolved Cases, KB, Schedules, History and Settings) which had been already configured by another helpdesk
manager/administrator.
You will be given the option to select the existing Team Helpdesk root folder, to link up the Team Helpdesk Manager
add-in with the existing Team Helpdesk folders and database.

Either you can auto scan

to search for the first available Team Helpdesk folder. If you already know the location of

Page

17

the existing Team Helpdesk folders, you can simply click the ‘Browse’
button to specify it from your Outlook and
then click ‘Continue’. Steps 6 and 7 would are not applicable, with this route.

Back to TOC

Step 6. A folders Installation Wizard dialog (as seen below) enables you to customize the name of the parent Team Helpdesk folder
that will be created. By default, it has a title of 'Team Helpdesk SP'.

Further, you can choose the language specific Outlook forms and Views to install. The following languages are supported:
English, Español, Norwegian, Danish, Dutch, Deutsch, French, Finnish, Swedish, Portuguese.

Step 7. Clicking 'Next' button would enable you to select an Outlook parent folder where the specified Team Helpdesk root folder
would be created. Hence make sure you have adequate rights over the selected folder to create a new folder.
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The tool would then copy Team Helpdesk subfolders, forms & designs, views
etc. from the Team Helpdesk PST template file. It would look like the
followings layout:

Back to TOC

NOTE: When you start Outlook, if you are not prompted for the option to copy a new Team Helpdesk folder, or choose existing one,
then most likely, there might be remnants of earlier installation. In such scenario, go to Outlook > Team Helpdesk Manager SP menu
and click ‘Copy a New Team Helpdesk folder’. That will manually invoke the wizard tool for copying a new Team Helpdesk folder to
your Outlook
Step 8. Now, the final step is to choose a Team Helpdesk database where all the settings, templates and other helpdesk data will be
saved. Supported database options are:
i) Microsoft Exchange/Outlook
ii) Microsoft Access
iii) Microsoft SQL Server
iv) Microsoft Azure SQL
v) Microsoft SharePoint

i) Microsoft Exchange/Outlook
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If Microsoft Exchange is selected, the settings data will be stored under the Team Helpdesk Settings public folder in Exchange. This
option removes the dependency of an external database and works even on WAN and HTTP connection to Exchange. This database
option is best used for quickly evaluating Team Helpdesk in your environment without needing to configure a dedicated database.
However, please be careful to not use this database option for your live production helpdesk, as it is unsuitable for multi-users
helpdesk environment.

Back to TOC

ii) Microsoft Access
If you choose Access, the database will need to be placed on a shared network folder such that all technicians working on the
support cases in Outlook have access to the network folder. When you specify the location where the MDB file is to be created,
make sure you choose a UNC path (e.g. \\AMTServer\Helpdesk\) instead of a mapped one because, a mapped drive might only be
accessible to you.

When using a network Access or SQL Server database, it is important that it is configured in a way that it is accessible on the network
by all support staffs. Note that, Team Helpdesk with a dedicated database only works on local network. This database option is ideal
for a helpdesk team that has a large number of technicians.
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NOTE: One important consideration with having a network Access database is the write permission on the folder and the MDB file
itself. Make sure, the shared folder or the MDB file is not configured ‘read-only’ for all technicians on the network, otherwise,
technicians won’t be able to create and save cases in the Team Helpdesk Cases folders in Outlook.

Back to TOC

iii) Microsoft SQL Server
It is recommended to use a dedicated SQL Server database option, if you have a high number of users/technicians working on
support cases, as it gives a better performance and is easily scalable.

For SQL server, the server name is mandatory. The Database name is optional. If it is left empty, a new database with the name
‘TeamHelpdeskSPSettingsDB’ would be created. If your SQL server is configured to use windows authentication (NTLM), then you
can check the ‘Use Integrity Security’ option to let Windows manager the credentials to access the resources on the SQL server. One
important aspect to consider when using a SQL server database is the accessibility by other technicians. That is, when other
technicians install the Team Helpdesk Agent, they will automatically pick up these SQL server settings to connect to the database,
and hence, it is important that the specified SQL server account here (if you are not using Integrated Security, that is) is usable by all
the technicians as well.
Permission for Technicians/Agents on the SQL database
Each of your helpdesk users/technicians should have both db_datareader and db_datawriter permission on the Team Helpdesk SQL
database.
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NOTE: When choosing a SQL server database for Team Helpdesk System, if you are not using the ‘Integrated Security’ (also known as
Windows Authentication, or NTLM authentication), then it is very important that the particular SQL user account you use here, is
usable by all Team Helpdesk Agents from different systems of the technicians.

Back to TOC

Using Cloud based SQL Server database
You can also use cloud-based SQL server service instead of on-premise such as Amazon RDS cloud service (They offer both
free and paid accounts. For more, refer to https://aws.amazon.com/rds/). For instance, below is our test MS SQL account with
Amazon RDS. Once you have signed up and created a MS SQL database, input the endpoint URL as server in our app. Make
sure, you suffix the port number after the endpoint as “,1433” so that the full URL in the server name would be
‘XXXXXXXXXXXXXXXXXXXXXXXXX.rds.amazon.com,1433’.
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And here is screenshot of the RDS server to use from the RDS member panel.

Back to TOC

iv) Microsoft Azure SQL
Azure SQL Database is a cloud-based relational database service from Microsoft, which is based on SQL Server database. This option
is ideal for helpdesk that have technicians scattered or working remotely in different locations but have access to the web.
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NOTE: If no database name is mentioned, Team Helpdesk will create a new database in your Azure SQL server, by the name of
'TeamHelpdeskSPSettingsDB’.

Back to TOC

v) Microsoft SharePoint
The last helpdesk database option ‘Microsoft SharePoint’ allows you to use your SharePoint site to store the helpdesk settings, drop
down lists, email templates and other global configurations such that all your technicians can access it from the internet or WAN.
This is ideal if many of your technicians’ work from remote location with no access to the office network but can access to the
company’s SharePoint site from outside the office network.

To specify a SharePoint site, click the ‘Browse…’ button. This would allow you to enter the URL of the SharePoint. When entering the
URL, always use the parent site URL in the format http://mySharePointsite. And click ‘Retrieve’ to show all available sub-sites and
lists.

Page

24

Very Important! Your permission to the SharePoint site: Make sure that you have ‘Full Control’ permission over the SharePoint site
so that Team Helpdesk Manager add-in can create the ‘TeamHelpdeskSPSettings’ list automatically.

Back to TOC

And then select the particular site under which the Helpdesk settings would be stored. You can also choose to create a new sub-site
on the fly by clicking the ‘New Site...’ button and select it. When you click ‘Confirm’, Team Helpdesk will automatically create and
configure a new SharePoint list titled ‘TeamHelpdeskSPSettings’ under the site. And then any settings/drop down lists you defined
from Team Helpdesk Manager Tool in Outlook would be saved in this repository.

If the SharePoint site uses the NTLM or
windows authentication, the add-in will use
the default credential to connect to the
SharePoint.
However, for form based or claimed based
authentication (for example, Office 365
SharePoint online), it may prompt you (and
another individual technician) to enter their
credential.
You can also specify the authentication
mode that is used by your SharePoint to
allow connection to it.
For instance, if your SharePoint is configured
for Windows authentication, choose ‘NTLM’.
If it used a form-based authentication, then
choose ‘Forms’ whereas if it used a claimed
based authentication (for Office 365
SharePoint Online), choose ‘Office 365’.

In the username, exclude any domain information. For instance, do not enter in the format DOMAIN\UserName. Only enter
UserName. If your SharePoint site login requires a domain name, enter one in the 'Domain' box instead. Check ‘Remember’ so that
Team Helpdesk add-in can use the same credential to logon to the SharePoint site in subsequent connection.
When your technicians with the Team Helpdesk Agent tool starts Outlook, the add-in would automatically connect to the admin
specified SharePoint site and would retrieve the helpdesk logic and settings data to the local system.
What SharePoint permissions are required for other technicians?
All technicians should have at least ‘Contribute’ permission the SharePoint list ‘TeamHelpdeskSPSettings’.
You can use any SharePoint version starting with SharePoint 2010 to the latest SharePoint 2016. You can also use Office 365
SharePoint Online too.
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Step 9. Once you click ‘Save’, the manager tool will automatically create the chosen database (if it does not exist already). And then
any project metadata and other settings/drop down lists you defined from Team Helpdesk Manager add-in in Outlook would be
saved in this repository.
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Now that you have installed - Team Helpdesk files into your system and Team Helpdesk folders into your public folder or
mailbox, administrator would need to configure the permission level of each Team Helpdesk folder, namely, the History
Ongoing, History Resolved, KB, Ongoing Cases, Resolved Cases, Schedules and Settings.
By default, the permission on each subfolder for all users is set to 'Author'. Only the user (manager) who had performed the
installation has got 'Owner' permission. Hence, it is this user (manager) who would need to grant permission to the folders for
all members of the helpdesk team. Without a proper permission structure defined, technicians accessing the Team Helpdesk

folders would not be able to perform most of the helpdesk tasks such as creating new support cases, working on their
assigned cases etc.
Folder
History Ongoing
History Resolved
KB
Ongoing Cases
Resolved Cases
Schedules
Settings

Permission
At least 'Editor' permission to all helpdesk technicians
At least 'Editor' permission to all helpdesk technicians
At least 'Author' permission to all helpdesk technicians
At least 'Editor' permission to all helpdesk technicians
At least 'Editor' permission to all helpdesk technicians
At least 'Editor' permission to all helpdesk technicians
'Publishing Editor' permission to technicians with admin-access*
At least 'Editor' permission to all helpdesk technicians
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We recommend that a user’s group consisting of all agents/technicians of the helpdesk be created such that helpdesk manager
(owner) can easily assign permission to the group as a whole, instead of undergoing multiple steps of selecting and granting the
same permission to each technician. In the example below, a group 'ServiceDesk' comprising of all helpdesk users is granted editor
permission over the 'Ongoing Cases' folder.
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The screenshot below lists all the files that are installed on the system. Notice, that, there are additional files which forms the
managerial option pack - tools to configure and install a new Team Helpdesk folder, which has to be performed only by the helpdesk
administrator/manager.
Add-in files under current user’s application data folder:
E.g. C:\Users\[USER]\AppData\Roaming\AssistMyTeam\Team Helpdesk Manager SP (x64 or x86) if it is 'Per User Installation'.
For 'Per Machine Installation', it would be C:\Program files (x86)\AssistMyTeam\Team Helpdesk Manager SP (x86 or x64)

Template PSTs/Forms/Web Access files under current user’s application data folder:
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E.g. C:\Users\[USER]\AppData\Roaming\AssistMyTeam\Team Helpdesk Resources SP
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4. Managerial Settings
The Team Helpdesk Manager include list managers to customize the contents of all drop-down boxes on the help desk form,
predefined answers, templates for outgoing emails and SMS, notification options, incoming emails monitoring, messaging, custom
fields etc. Besides managing the settings and drop-down lists, it is responsible for monitoring email folders and mailboxes for
automatic processing of incoming emails to support cases, as well as processing web requests coming from Technician Web Access
(TWA) and Customer Web Service (CWS) websites.
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Team Helpdesk Manager Menu
The Team Helpdesk menu serves as the gateway for launching most of the functionalities and tools available in Team
Helpdesk for Outlook. In Outlook 2016, you would find the Team Helpdesk Manager menu in the backstage file button, as
shown below.
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4.1 Helpdesk Settings Data Source
Being a groupware solution, Team Helpdesk add-in requires that it stores the settings, templates and other helpdesk data on a
dedicated database, which is accessible to all the technicians of your helpdesk. When you install the managerial tool first time, you
will be prompted to choose a database to be used for Team Helpdesk settings.

Supported database options:
i) Microsoft Exchange/Outlook
If Microsoft Exchange is selected, the settings data will be stored under the Team Helpdesk Settings public folder in
Exchange. This option removes the dependency of an external database and works even on WAN and HTTP connection
to Exchange. This database option is best used for quickly evaluating Team Helpdesk in your environment without
needing to configure a dedicated database. However, please be careful to not use this database option for your live
production helpdesk, as it is unsuitable for multi-users helpdesk environment. For more information, refer to section
‘Installation > Exchange/Outlook database‘.
ii) Microsoft Access
If you choose Access, the database will need to be placed on a shared network folder such that all technicians working
on the support cases in Outlook have access to the network folder. For more information on using Access with Team
Helpdesk, refer to section ‘Installation > Microsoft Access database‘.
iii) Microsoft SQL Server
It is recommended to use a dedicated SQL Server database option, if you have a high number of users/technicians
working on support cases, as it gives a better performance and is easily scalable. For more information on using SQL
Server with Team Helpdesk, refer to section ‘Installation > SQL Server database‘.
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iv) Microsoft Azure SQL
Azure SQL Database is a cloud-based relational database service from Microsoft, which is based on SQL Server database.
This option is ideal for helpdesk that have technicians scattered or working remotely in different locations but have
access to the web. For more information on using Azure SQL with Team Helpdesk, refer to section ‘Installation > Azure
SQL database‘.
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v) Microsoft SharePoint
This allows you to store the helpdesk settings, drop down lists, email templates and other global configurations to a
SharePoint list such that all your technicians can access it from the internet or WAN. This is ideal if many of your

technicians’ work from remote location with no access to the office network but can access to the company’s
SharePoint site from outside the office network. For more on using SharePoint with Team Helpdesk, refer to section
‘Installation > SharePoint database’.
Importing Database Configuration from file - Database configuration file (*.dbconfig) can be imported on new machine
or new agent from 'Helpdesk Settings Data Source' panel. And the manager/agent addin on that system will read the
location and connect to the configured database automatically
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Saving database configuration to file: Database configuration can be saved to a file (having *.dbconfig file extension)
from Helpdesk Settings Data Source panel and manager can share/deploy this .dbconfig file to other agents/users (say,
via email or file server) so that individual technician can import that .dbconfig file to connect their manager/agent addin
to the correct Team Helpdesk folder/database in their respective Outlook.
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4.2 SharePoint Mapping – Support Case
When a support case is generated in Outlook, either manually by the technician, or automatically from an incoming email on a
monitored mailbox, as a helpdesk manager, you can choose which Outlook helpdesk fields get included in the SharePoint copy of the
case. All you need to do is map the Outlook helpdesk fields with relevant fields of the SharePoint list. Mapped settings are then
accessible by all technicians in the helpdesk.
When you try to perform mapping for the support case with SharePoint, you will be prompted to enter the URL of your SharePoint
site from which you can choose the particular destination SharePoint list under which copies of the cases raised in Outlook will be
synchronized and stored.

You can re-use existing SharePoint lists or create new one for this purpose. Ideally, we recommend that the SharePoint list you will
choose for used with Team Helpdesk was derived from the ‘Issue Tracking’ template in your SharePoint. This is because such
SharePoint list already comes with predefined helpdesk fields and views which can be directly ported with Team Helpdesk’s
functionality.
Creating a new SharePoint list in your SharePoint site via web browser
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For instance, you can create a new list (e.g., Tickets) based on the ‘Issue Tracking’ template below:
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And then choose this newly created SharePoint list (e.g. Tickets) or any other existing lists from the mapping tool and click
‘Continue’.

Instead of creating the new site/list in the SharePoint using your web browser, you can also choose to create – new site or list
directly from the add-in.
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New Site – Create a new site directly under the chosen parent site to be used exclusively for Team Helpdesk. By
default, the site will be created as a blank site, unless a different site template is chosen from the drop down.
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New List – You can choose to create a new list directly under the chosen site. By default, the list would be created
using the ‘Issue Tracking’ template available in your SharePoint. However, you can change the template from the drop
down.

After choosing a destination SharePoint list (either by creating a new one, or by selecting an existing list), you can proceed to start
mapping the fields between Outlook and SharePoint.
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In the mapping dialog box (above), the first column lists all the Helpdesk Outlook fields. The second column displays the data type of
the field. In the third column, there is a drop-down list on each row, consisting of all available SharePoint fields. Just simply choose a
SharePoint field from the drop-down box to map it to the corresponding Outlook field.
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For example, in the screenshot above, Outlook Helpdesk field ‘Due Date’ is mapped to SharePoint field ‘Due Date’, and Helpdesk
field ‘Problem Category’ to SharePoint field ‘Category’ etc.

You can choose to auto create the required fields in the SharePoint list as well as auto-map the fields between the helpdesk and
SharePoint.
For mandatory unmapped fields only - Click this option under the ‘Auto Create & Map fields’ menu to create the
mandatory helpdesk fields in the chosen SharePoint list on the fly and automatically complete the mapping.
Mandatory fields are marked/colored in light red. The following fields are mandatory to complete the mapping Subject, Consolidated Conversation, Caller Name, Resolved, Due Date, Problem Category, Problem Type, Technician
For all unmapped fields – Click this option under the ‘Auto Create & Map fields’ menu to create all the helpdesk fields
that have not been mapped yet in the chosen SharePoint list and complete the mapping automatically. If the chosen
SharePoint list have any matching existing fields, instead of creating new ones, the add-in will try to use them to map
with the helpdesk fields. For instance, if the chosen SharePoint list was created based on the ‘Issue Tracking’, the list
already contains predefined fields such as Title, Due Date, Description, Assigned To, Issue Status etc.
For the following fields – Click this option under the ‘Auto-Create & Map fields’ menu to choose specific helpdesk
fields of interest that will be auto-created in the chosen SharePoint and mapped automatically.
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For ‘Caller Name’ field, you can further specify which SharePoint data type will be used to store the caller information
contained in the case in Outlook. For instance, you can choose if the SharePoint caller name field will store the info as a
SharePoint user/group type (assuming the caller exists as a user in SharePoint), or as a choice drop down, or as a plain
text. By default, the ‘Caller Name’ field is set to be used and mapped to a SharePoint ‘Text’ field.
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For ‘Technician’ field, you can also specify which SharePoint data type will be used to store the technician information
contained in the case in Outlook. For instance, you can choose if the SharePoint Technician field will store the info as a
SharePoint user/group type (assuming the technician exists as a user in SharePoint), or as a choice drop down, or as a
plain text. By default, the ‘Technician’ field is set to be used and mapped to a SharePoint ‘User/Group’ field.
Additionally, to have finer control, you can also manually create new fields in the chosen destination SharePoint list and map with
the helpdesk outlook fields.
Create New SharePoint Field - on the fly.
In the drop-down list of the SharePoint field, you will also notice that there is an item ‘[NEW LIST FIELD]’. You can select this item to
create a new field in the particular SharePoint list, directly from this mapping tool, so that you can map the specific Outlook field to
this new SharePoint field, without requiring you to create it in your SharePoint site.

Specify a field name that you would like to appear in the
SharePoint list. Only input valid characters and avoid using
special characters such as symbols.

The new SharePoint field will have the same data type as that of the corresponding Outlook field.

Mandatory Fields for Mapping.
Note that the following Outlook Helpdesk fields are mandatory when you perform mapping:
Subject, HTML Body (or Consolidated Conversation), Caller Name, Technician, Problem Category, Problem Type, Due Date, Resolved.

Page

35

If any of these mandatory field(s) are not mapped, you will get a ‘mandatory fields not mapped’ warning message and the settings
won’t be saved.
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Available Helpdesk Fields in Outlook for mapping to SharePoint:
Asset Name, Asset Field 2, Asset Field 3, Asset Field 4, Asset Field5, Author, Caller Address, Caller Company, Caller Department, Caller
Mobile, Caller Phone, Resolved, Date Closed, Date Created, Due Date, Log, Notes, Origin, Problem Category, Problem Type, Received
Date, Service Level, Status, Technician, Technician Email, Time Spent, Time Spent Description, Subject, Body, HTML Body, Importance,
Categories, Other Cases from the same caller, Other Cases related to the same Asset (and any custom fields you have defined).

4.3 SharePoint Mapping – KB Article
when a KB article is published in Outlook, you can choose which Outlook KB fields get included in the SharePoint copy of the KB
article. All you need to do is map the Outlook KB fields with relevant fields of the SharePoint list. Mapped settings are then
accessible by all technicians in the helpdesk.
When you try to perform mapping KB with SharePoint, you will be prompted to enter the URL of your SharePoint site from which
you can choose the particular destination SharePoint list under which copies of the KB articles in Outlook will be synchronized and
stored.

And it would be used to store all the copies of KB article items, available in Outlook. You can use a simple custom list as it does not
require that many fields. For instance, you can use the ‘Custom List’ template to create a new SharePoint list ‘KB’ for used with Team
Helpdesk to store the KB articles.
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And then choose this newly created SharePoint list (e.g. KB) or any other existing lists.
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In the mapping dialog box (above), the first column lists all the KB Outlook fields. The second column displays the data type of the
field. In the third column, there is a drop-down list on each row, consisting of all available SharePoint fields. Just simply choose a
SharePoint field from the drop-down box to map it to the corresponding Outlook field.

For example, in the screenshot above, Outlook KB field ‘Subject’ is mapped to SharePoint field ‘Title’, and Outlook Helpdesk field
‘HTML Body’ to SharePoint field ‘HTMLBody’ etc.
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Available KB Fields in Outlook for mapping with SharePoint:
Subject, Body, HTML Body, Problem Category, Problem Type.
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4.4 SharePoint Case Settings
Helpdesk Manager can further customize how the individual support case appears in SharePoint.

Retain attachments in the SharePoint Case item – If enabled, Team Helpdesk will also upload the associated
attachments from Outlook to SharePoint. And the attachments will appear as hyperlinks at the bottom of the
SharePoint case form.

Upload associated emails as MSG attachments – If this is enabled, Team Helpdesk will generate MSG file format of the
related emails, and upload as attachments to the SharePoint Case item.
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Retain embedded images in SharePoint Case Item – If this is enabled, any embedded or inline images that may exist in
the Outlook case item, will also be retained in the SharePoint copy of the case.
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Update SharePoint Case item automatically when corresponding Outlook case item is modified/changed – When
enabled, Team Helpdesk will automatically perform an update to the SharePoint copy of the support case, when the
Outlook case item is modified. This process helps in keeping the support cases in both Exchange and SharePoint in
sync.
Embed shortcut to the SharePoint support case URL into the Original mail item – This will insert a hyperlink to the
original Outlook mail item, from which the particular support case was generated. Clicking this embedded link will
open the
When deleting a Case item from Outlook, delete the corresponding SharePoint Case item too – If enabled, Team
Helpdesk will also remove the particular SharePoint copy of the Support Case, when the corresponding Case item is
deleted from Outlook.
Open SharePoint case item automatically when it is logged – Enable this option to show the newly created SharePoint
case item in web browser.
Open KB form automatically when it is created from Outlook items – Enable this option to show the newly created
SharePoint KB item in web browser.
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For SharePoint Choice fields, allow user to input their own value – Enable this option to enable users to input their
own value in the helpdesk drop down fields of the SharePoint list.
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4.5 Assets Configuration and Tracking
The helpdesk is a vital part of the company who wants to get the most out of its IT assets. The assets list allows you to track and
manage support request from your internal users for quick resolution to the case. There are 5 asset fields available out of which 4
are customizable according to your need. Out of the 4, 2 of them are drop-down fields. In the above screenshot, we have taken the
example of computing resources used by internal staffs. We have customized the 2nd and 3rd fields as Asset type and Asset OS,
which takes a drop-down list. Both the drop-down lists are available on the right. The 4th and 5th fields (e.g. Asset IP, Asset Make)
take the normal text data.

The titles of these customizable fields can be set in 'Asset Fields' settings.

Input a unique identifier name of the asset.
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Input a title for the 2nd field of the asset. This takes a drop-down list which you can define under the first tab of right
side.
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Input a title for the 3rd field of the asset. This also takes a drop-down list which you can define under the second tab of
right side.

Input a title for the 4th field of the asset. This takes a static text type.
Input a title for the 5th field of the asset. This also takes a static text type.
Allow addition of new asset that was entered in the case form to the global assets list and save to the database.
Give a title that best describe the asset or equipment you are trying to tracking with Team Helpdesk.

Additional Asset fields
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By default, Team Helpdesk has provision for 5 predefined asset fields. However, if you need more, the manager can define and add
any number of secondary asset fields that takes varying data types such as text, number, yes/no, note, date or currency under Team
Helpdesk Manager > Asset Fields panel (Additional Fields, Additional Lists tabs). All defined custom fields are available in summary
reports and OLAP Statistics tool.
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4.6 Callers list
Team Helpdesk can maintain the detail of the callers that request for support. The caller's email address is a mandatory field
and should be unique for each caller that you entered. If there has to be phone calls to callers from within Team Helpdesk
(say, from the outlook form), the phone and mobile need to be filled up. The mobile field is also necessary if callers have to
receive SMS notifications in their mobile device. The department field has a restricted range (as being a drop-down field) i.e.,
it can take only take a value from the caller categories.

Import callers from Global Address List/Active Directory - Most likely, you might already have contact details of
the callers in the exchange global address list. Use the 'Import...' button to display the address book and select
those contacts that you want to import. The contact's name, email, department, company, address, telephone,
mobile fields would be then automatically filled in the grid.
Default technician - Each caller entry can also take a default technician. This is useful if you want to dynamically
assign this default technician to a case (just generated from an email or a web form submission) send by a
particular caller (that exist in the Team Helpdesk callers list). This setup automatically triggers the notifications to
the concerned technician in the form of email, SMS etc.
Caller Web Access (CWA) Password - To access the Caller Web Access (CWA) site from a web browser via the
internet, the caller requires a password. This password is defined by the helpdesk manager when a new caller is
added. Alternatively, it can be generated automatically when a new, non-existent caller is added to the Team
Helpdesk callers list. The password can then be set to insert into the notification/confirmation email sent out to
caller first time when a support case is logged from their email/call/web submission

Departments & Companies
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Specify what all internal departments your help desk team would support incoming service requests from callers. You can
then use a category/department to associate each caller. You can also specify the default hourly rate for each department, so
that, when using statistics, you can consider this rate, besides the other two rates - technician rate and problem category rate.
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4.7 Technicians List
Team Helpdesk System needs to maintain the detail of the technicians that would be working on support cases. The
technician name and email address are mandatory fields and should be unique for each technician that you entered. If there
has to be calls to technicians from within Team Helpdesk (say, from the outlook form), the phone and mobile needs to be
filled up.
There is also an option of making the mobile number of the technician as the primary contact (e.g. when making Calls, Team
Helpdesk will use the mobile number instead of the phone number). The mobile field is also necessary to receive SMS
notifications they are enabled.

Import technicians from Global Address List/Active Directory - Most likely, you might already have contact details of the
technicians in the exchange global address list. Use the 'Import...' button to display the address book and select those
contacts that you want to import. The technician's name, email, telephone, mobile fields would be then automatically
filled in the grid.
Admin Access - The administrative settings and tools in Team Helpdesk can be allowed selective access to technicians.
Enable this option to categories which technicians should have administrative access and which should not. By default,
this option is disabled, which means all technicians will have administrative access. Learn more.
WebAccess Password - The password field is used to authenticate technicians when they logged in to the Team Helpdesk
Web Access interface on a browser. Please note that this password is different than the one used in the active directory
account.
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Supervisors – You can assign one or more supervisors specific to each technician so that when a SLA breach occurs on
cases, the associated supervisors are automatically escalated and notified.
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4.8 Categories, Types and Statuses Management
Problem management is critical to ticketing system. After detecting a problem, helpdesk manager should log and categorize
the problem into a main category and secondary type. This step is beneficial in several ways.
•
•
•

Allows the helpdesk to sort and model incidents that occur regularly.
Allows for automatic assignment of prioritization such as agents, Service Level Agreements (SLA).
Ability to gather and report on helpdesk tickets data. This data allows the organization to not only track problem
trends, but also to assess its effect on service demand and helpdesk capacity.

With Team Helpdesk, you can maintain a list of problems (as categories, types, statuses) that is representative of all possible
incidents reported by your end users.

Problem categories list
Gather all the problem areas that your support team will be attending to and feed them into the 'Category' field.
You can also specify the default hourly rate for each problem category, so that, when using statistics, you can
consider this category rate, besides the other two rates - technician, caller department.

Problem statuses list
As technicians start working on assigned cases, over time, they may need to update the state of the tagged
problem so that senior technicians or managers can track and plan additional resources if needed to resolve that
particular case. Such a list of status flags can be specified.
The color code column allows you to associate a
color with a status. And case item in Outlook that is
tagged with a problem status will be colorized with
the associated color.
You can choose from one of the 20 colors
supported by Outlook for color coding Outlook
items (via Categories field of the Outlook item).
To specify a color code for a status, double-click the
corresponding second cell (color code column).
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When you set the status of the case or when the add-in does that automatically using the default status values set
for various events, you will see that the categories column of the case item has color-coded status.
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(NOTE: For color coding of cases with status color code, you need to enable the option 'Allow Color Coding of Case
items based on the status of the case' from Team Helpdesk Manager > Automation Options > Other Information)
And if you preview the case or view it in the case form, you will also see the color bar in the header.

Problem Field List
This is customizable drop-down field that is provided to complement the multiple hierarchical representation of
the problem type.
This field appear in the Outlook case form, (just like the
Problem Category and type fields) and selecting a particular
problem type would automatically populate the
corresponding value for this field too.
You can change the title of this problem field. By default, it
is named as 'Problem Field', but you can change it to suit its
purpose. For example, in the screenshot above, this special
problem field is named as ‘Zone’, and the possible values
are defined in the list.

Page

45

When you open the case form, you will see a new field 'Zone' is now available with a drop-down field. When you
select a particular problem type, the value of this problem field (i.e., Zone) would be automatically assigned, based
on the linked relationship, that existed in the Problems list. Lastly, this new column (or field) should also be
available in the summary reports and OLAP Statistics tool.
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Problem types list
The problem types are sub-category items that fall within the domain of a problem area/category. Hence, each problem
category has a specific list of problem types that a technician/manager can choose from and tag a support request case.

In the Outlook case and knowledge base form, when a technician selects from the problem category drop down, it will load
this tier of problem type lists in the type drop-down box. These nested tiers of categories/types are complete customizable to
your organization's support model and act as somewhat of a guiding decision tree for the caller (when submitting online
service request) and technicians etc. These also assist in providing high-level information to help desk managers in automatic
assignment of cases to the correct technician.

Problem Category to which this problem type belongs to. If a particular problem type is applicable to all problem
categories, leave it as empty. That is, if you have a common problem type for all Problem categories, you don’t
need to add the same problem type for each category. Just leave the Problem Category column empty for that
problem type.
Default time (in minutes) under which the particular problem is expected to be fixed/resolved.

Default technician who has expertise on that problem. You can also assign multiple technicians to a problem type.
And these default technicians could be automatically assigned to cases that are tagged with this problem type.
Default SLA under which the problem fits into. A problem’s priority is determined by its impact on users and on
the business and its urgency. Urgency is how quickly the organization requires a resolution to the problem. The
impact is a measure of the extent of potential damage the problem can cause the organization. Prioritizing the
problem allows organizations to mitigate damage to the service level agreement (SLA) by reallocating resources as
soon as the issue is known.
Choose a default problem field (titled as ‘Zone’ in our example) from the drop-down list for a problem type.
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Code – This is an abbreviated code that you can define for each problem type. This could be one of the tracking
code that helpdesk manager can configure for embedding into the subject of the case item (along with the case ID)
for easy recognition and tracking.
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4.9 Custom Fields
You can deploy any number of custom fields that take different data types and these fields will be available in the Custom
fields tab of the case form in Outlook, such that, when you are raising a ticket from an email or phone call, you can fill in the
value directly. All defined custom fields are available in summary reports and OLAP Statistics tool.
You can define such custom fields that take the following data types: Text, Number, Currency, Yes/No, Date/Time, Note or
drop-down List.

Custom fields can be of 6 different data types as displayed in the image above:
Currency, Date/Time, Numeric, Text, Yes/No, Note.
You can add any number of Custom fields as required and they will all appear in the case form in Outlook.
You also have the option to even mark a custom field Mandatory, so that without filling the mandatory fields, a case
couldn’t be mark completed. Once a field is marked mandatory it would be displayed in red color so that user can
identify the mandatory fields.
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Custom List - The titles of these custom list can be edited to get the proper meaningful label that signifies the
information the field store. For example, the first drop down field can be titled as ‘Client’ and the administrator can fill
up the names of all their clients for which projects are contracted for.
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When you open a case in Outlook, the custom fields are available to collect further data on the caller or problem or related to the
case in general.
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4.10 Access Control
In this panel, the administrator can control what particular subset of features and options are available to the technicians.

Allow conversion of non-mail items to support case - The manager can also define which particular type of Outlook items
are possible candidates for generating support request cases. By default, support requests can be generated from mail
items only. To enable other Outlook item types, select the appropriate checkboxes - Post, Meeting or Task.
Disable balloon popup notification - Disable a balloon popup notification when a major event occurred in Team Helpdesk
System. By default, it is unchecked.
Open Support Case form automatically when it is generated from other Outlook items - Enable this option to
display/open the inspector window of the support case just created. This is only applicable when the case is generated
manually from an email or other Outlook item.
Open knowledge base form automatically when it is generated from other Outlook items - Enable this option to
display/open the inspector window of the knowledge base just created.
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Limit access to non-admin technicians - The administrative settings and tools in Team Helpdesk can be allowed selective
access to technicians. Enable this option to categories which technicians should have administrative access and which
should not. By default, this option is disabled, which means all technicians will have administrative access.
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List of team members with no admin access (one with the red background). You can use the buttons >> or << to
swap the access level.

List of team members with admin access (one with the green background). You can use the buttons >> or << to swap the
access level
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Restrict certain managerial specific fields (such as SLA, Due Date, Assigned Technicians, Problems etc.) in the support case
form from being edited by support workers with no admin access.
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4.11 Origin List
In Team Helpdesk, a case could be raised from different source such as an email, phone call, contact, or from web form. In
the case form, a ‘Origin’ field is provided that shows the source of the case. Helpdesk managers can add the number of
difference origin a case could be originated from.

And further, each origin in the list can be mapped or associated with the predefined header under Team
Helpdesk Manager > Origin Options.

Choose an origin value (defined in the Origin List) that will be associated with cases that were raised from Outlook
emails.
Choose an origin value (defined in the Origin List) that will be associated with cases that were raised from Outlook
tasks.
Choose an origin value (defined in the Origin List) that will be associated with cases that were raised from Outlook
appointments.
Choose an origin value (defined in the Origin List) that will be associated with cases that were raised from Outlook
contacts.
Choose an origin value (defined in the Origin List) that will be associated with cases that were raised from phone
calls.
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Choose an origin value (defined in the Origin List) that will be associated with cases that were raised from web
form (Technician Web Access site).
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Choose an origin value (defined in the Origin List) that will be associated with cases that were raised from web
form (Customer Web Service).

4.12 Templates Manager
Team Helpdesk uses various templates (emails as well as SMS) for sending out notifications and reminders to callers and
technicians - both manual and automatic. Email notifications take HTML format whereas SMS notifications use plain text.
There are a whole lot of notification options for different events such as when a case is created, changed or resolved, or when
a technician is assigned to the case, or when the due date has lapsed etc. Automated emails and SMS are sent out directly
when a relevant event occurs and the whole exercise is transparent to the technicians.
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A list of all templates used for print, email or mobile SMS. The followings are the available templates:
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Template
New case

Purpose
HTML template used in logging new support request case (applicable
on both manual and automatically created cases)

Print

HTML template used when printing the support case item in Outlook

Email caller from case form

HTML template used when contacting the caller of a case

Email technicians from case form

HTML template used when contacting the technician responsible for a
case

Email caller on case closure

HTML template used in the automated email to the caller to notify
about the successful resolution to the allotted case

Email technicians on case assignment

HTML template used in the automated email to the technicians to
notify when a case is assigned

Email technicians on case reopening

HTML template used in the automated email to the concerned
technicians when a resolved case has been re-opened

Email technicians on due-date lapse

HTML template used in the automated email to the concerned
technicians when the due date of a case is about to be overdue

Email technicians on respond by date
lapse

HTML template used in the automated email to the concerned
technicians when the respond by date of a case is about to be overdue

Email caller on technician assignment

HTML template used in the automated email to the caller when new
technicians are assigned or existing ones changed

Email technicians on caller reply

HTML template used in the automated email to concerned technicians
to inform about new replies from the caller

Email supervisors on SLA breach (Due
Time)

HTML template used in the automated email to helpdesk supervisors to
inform about SLA breach occurrence on due time lapse

Email supervisors on SLA breach
(Response Time)

HTML template used in the automated email to helpdesk supervisors to
inform about SLA breach occurrence on response time lapse

Email Supervisors on New Case

HTML template used in the automated email to supervisors to inform
about a new case

Email Supervisors on new technician
assignment

HTML template used in the automated email to supervisors to inform
about assignment of technicians to a case

Email Technicians on KB publication

HTML template used in the automated email to all helpdesk staffs to
inform about new KB publication

Email Managers on new unassigned case

HTML template used in the automated email to managers to inform
about an unassigned case

Email Managers on First Time Caller
registration

HTML template used in the automated email to managers to inform
about new caller being added and registered with the helpdesk

Email Supervisors on case closure

HTML template used in the automated email to supervisors to inform
on the completion and closure of a case

Email Managers on case closure

HTML template used in the automated email to managers to inform on
the completion and closure of a case

SMS caller from case form

Plain text template used when contacting the caller of a case

SMS technicians from case form

Plain text template used when contacting the technician responsible for
a case

SMS caller on case allotment

Plain text template used in the automated SMS to the caller to notify
about the successful logging of the support request
Plain text template used in the automated SMS to the caller to notify
about the successful resolution to the allotted case
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SMS caller on case closure
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SMS technicians on case assignment

Plain text template used in the automated SMS to the technicians to
notify when a case is assigned

SMS technicians on case reopening

Plain text template used in the automated SMS to the concerned
technicians when a resolved case has been re-opened

SMS technicians on due-date lapse

Plain text template used in the automated SMS to technicians when the
due date of a case is about to be overdue

SMS technicians on respond by date
lapse

Plain text template used in the automated SMS to technicians when the
respond by date of a case is about to be overdue

SMS caller on technician assignment

Plain text template used in the automated SMS to the caller when new
technicians are assigned or existing ones changed

SMS technicians on caller reply

Plain text template used in the automated SMS to concerned
technicians to inform about new replies from the caller

SMS supervisors on SLA breach (Due
Time)

Plain text template used in the automated SMS to helpdesk supervisors
to inform about SLA breach occurrence on due time

SMS supervisors on SLA breach
(Response Time)

Plain text template used in the automated SMS to helpdesk supervisors
to inform about SLA breach occurrence on response time

SMS technicians on KB publication

Plain text template used in the automated SMS to all helpdesk staffs to
inform about new KB publication

SMS managers on unassigned case

Plain text template used in the automated SMS to managers to inform
about an unassigned case

SMS Managers on first time registration

Plain text template used in the automated SMS to managers to inform
about new caller being added and registered with the helpdesk

SMS Supervisors on case completion

Plain text template used in the automated SMS to managers to inform
on the completion and closure of a case

SMS Managers on case completion

Plain text template used in the automated SMS to managers to inform
on the completion and closure of a case

The actual template in its raw state. A WYSIWYG HTML editor with which you can customize the contents, apply
HTML formatting as well as insert the placeholder variables. The look and feel as well as the buttons and
functionalities are similar to Microsoft FrontPage authoring tool.
Subject of the active template. It is also customizable and can take placeholder variables.
A list of all placeholder variables available for inserting into a particular template. In runtime (that is, when the
actual email or SMS is generated from the template), the enclosed variables will be substituted by their
corresponding values. The followings list all the supported variables:
Variable
SDO_CASEDESCRIPTION
SCO_EMAILBODY
SCO_CASENUMBER
SCO_SUBJECT
SCO_CASEAUTHOR
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SCO_DATERECEIVED
SCO_DATECREATED
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SCO_PROBLEMCATEGORY
SCO_PROBLEMTYPE
SCO_STATUS
SCO_EMAIL_HISTORY_LISTING
SCO_TIMESPENT_DESCRIPTION
SCO_TOTAL_TIMESPENT

Purpose
Description of the support request case
Body of the caller email
Case Number of the generated support case
Subject of the email or the support case
The help desk staff that created/logged the
support request
Date and time the email was received
Date and time the support case was
created/logged
Problem category to which the case belongs to
Problem type to which the case is related with
Status of the case with regards to the problem
Email history listing on the current case
Description on each time that a technician spent
in working on the case
Total time spent (in minutes) on the case

SCO_LOGS
SCO_NOTES
SCO_CALLERNAME
SCO_CALLEREMAIL
SCO_CALLERPHONE
SCO_CALLERMOBILE
SCO_CALLERDEPARTMENT
SCO_CALLERADDRESS
SCO_TECHNICIANS
SCO_DUEDATE
SCO_PRIORITY
SCO_ASSETNAME
SCO_ASSETCOMMENTS
SCO_NOW
SCO_CUSTOMFIELD1
SCO_CUSTOMFIELD2
SCO_CUSTOMFIELD3
SCO_CUSTOMFIELD4
SCO_REPLIEDEMAILBODY
SCO_REPLIEDEMAILSUBJECT
SCO_WEBACCESS_LOGIN
SCO_WEBACCESS_URL
SCO_KBBODY
SCO_KBSUBJECT
SCO_KBPROBLEMCATEGORY
SCO_KBPROBLEMTYPE
SCO_KBLINK
SCO_KBCREATEDDATE

Log listings related to the case
Nodes added on the case by technicians and
managers
Name of the caller who had requested for help
Email address of the caller
Telephone number of the caller
Mobile number of the caller
Department to which the caller belongs
Full address of the caller
Technicians assigned to the case
Due date assigned to the case within which the
case has to be resolved
Priority of the case
Asset name related to the case
Comments on that particular asset
Current date and time
Custom Field 1
Custom Field 2
Custom Field 3
Custom Field 4
Description body of the caller replied email
Subject of the caller replied email
Caller login details for web access
The web URL of the Caller Web Access (CWA) site
Description body of the newly published KB
article
Subject of the newly published KB article
Problem Category of the newly published KB
article
Problem Type of the newly published KB article
Outlook link of the newly published KB article
clicking which will open the KB article
Creation date of the newly published KB article
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Reset button – click this to reset any changes made to the selected template and revert back to the original
template content.
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Allotment Templates

An allotment template is used for notifying caller when a case is raised from their support request. In Team Helpdesk, managers can
define multiple allotment templates, so that one can choose which specific allotment auto-response to send to a particular caller.
For instance, if someone sends an e-mail to UK.Support@myCompany.com, you would want to inform the customer that their email will be responded to within 2 hours between 9 am and 5:30 pm GMT. If they send a new case to US.Support@myCompany.com,
you can inform the customer that their e-mail will be responded to within 3 hours between 9 am and 5:30 pm EST.
Create a new allotment template based on default content.
Create a new empty allotment template.
Rename the selected allotment template.
Delete the selected allotment template.
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List of all allotment templates available.
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4.13 Notification Options
Automatic Email and SMS Notifications - Automatic email notification and SMS alerts are essential for keeping callers and
technicians informed with the progress and status of the case. Team Helpdesk offers a whole lot of notification options for
different events such as when a case is created, changed or resolved, or when a technician is assigned to the case, or when
the due date has lapsed etc. The template for such a notification email or SMS is available for customization as discussed
earlier. Automatic emails are sent out directly when a relevant event occurs and the whole exercise is transparent to the
technicians. Same is the case of automatic SMS messaging.
Check the box of email or SMS of the corresponding notification that you want to enable and then click 'Save' button.

Email Alerts
Here you can enable or disable automated email notifications. To enable a particular email notification, check the
corresponding box.
NOTE: To customize the template of each of the notification as per your requirement, use the Templates Manager.
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SMS Alerts
Here you can enable or disable automated SMS notifications. To enable a particular SMS notification, check the
corresponding box.
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Automated Email Notification Samples
Here are few samples of automated email notification as send to recipient from Team Helpdesk

Email notification to caller when a support case is logged from an email/call
As soon as a support case is logged with Team Helpdesk and saved in Outlook/Exchange, a notification email is send out
automatically to the caller (using a customizable template) informing about the detail of the generated case including the
case number.

Email notification to caller when technicians are assigned to their cases
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A simple example is when a new case is generated, and the helpdesk manager assigns it to a new technician. As soon as it is
saved and exited out of the case, Team Helpdesk automatically send out the notification email to caller (using a
customizable template) informing about the assignment of the new technician. If existing technicians are changed, the
same notification would trigger and the caller is updated to put on the communication loop.
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Email notification to caller when a case is closed

When a technician marked a support case as fixed, it is closed and move to the 'Resolved cases' folder. At the same time, a
notification email is send out automatically to the caller (using a customizable template) informing about the closure of the
case.

Email notification to assigned technicians when a case is reopened

Page

59

This scenario would happen when the caller replies back to a support case that had been already marked as resolved in
Outlook/Exchange. Team Helpdesk would then automatically reopen the case and sent notification email to the assigned
technicians. When reopened, the particular case would be moved from the 'Resolved Cases' folder to the 'Ongoing Cases'
folder.
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Email notification to assigned technicians when the due date is about to lapse
This scenario would happen when the caller replies back to a support case that had been already marked as resolved in
Outlook/Exchange. Team Helpdesk would then automatically reopen the case and sent notification email to the assigned
technicians. When reopened, the particular case would be moved from the 'Resolved Cases' folder to the 'Ongoing Cases'
folder.

Email notification to technicians when a case is assigned
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An automatic notification email would be sent out to the assigned technicians when cases are assigned.
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Automated SMS Notification Samples
Here are few samples of automated SMS notification as send to recipients from Team Helpdesk

SMS notification to caller when a support case is logged from an email/call
As soon as a support case is logged with Team Helpdesk and saved in
Outlook/Exchange, a notification SMS is send out automatically to the
caller (using a customizable template) informing about the detail of the
generated case including the case number.

SMS notification to caller when technicians are assigned to their cases
A simple example is when a new case is generated, and the helpdesk
manager assigns it to a new technician. As soon as it is saved and exited
out of the case, Team Helpdesk automatically send out the notification
SMS to caller (using a customizable template) informing about the
assignment of the new technician. If existing technicians are changed,
the same notification would trigger and the caller is updated to put on
the communication loop.

SMS notification to caller when a case is closed
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When a technician marked a support case as fixed, it is closed and move
to the 'Resolved cases' folder. At the same time, a notification SMS is
send out automatically to the caller (using a customizable template)
informing about the closure of the case.
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SMS notification to assigned technicians when a case is reopened
This scenario would happen when the caller replies back to a support
case that had been already marked as resolved in Outlook/Exchange.
Team Helpdesk would then automatically reopen the case and sent
notification SMS to the assigned technicians. When reopened, the
particular case would be moved from the 'Resolved Cases' folder to the
'Ongoing Cases' folder.

SMS notification to assigned technicians when the due date is about to lapse
This scenario would happen when the caller replies back to a support
case that had been already marked as resolved in Outlook/Exchange.
Team Helpdesk would then automatically reopen the case and sent
notification SMS to the assigned technicians. When reopened, the
particular case would be moved from the 'Resolved Cases' folder to the
'Ongoing Cases' folder.

SMS notification to technicians when a case is assigned
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An automatic notification SMS would be sent out to the assigned
technicians when cases are assigned. This includes for technicians
assigned automatically due to relationship defined between a default
technician and a problem type/caller such as support request submitted
via web form or when existing a caller sends an email.
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Adding Attachments to automated notification emails

Attachments to include in case allotment notification - Often most helpdesk policy requires that certain
documents such as EULA, disclaimer or Service agreements etc., are also send along with the automated email to
the caller when a ticket is allotted.
NOTE: Such document files should be placed on a network shared folder e.g., \\Server\File so that, Team Helpdesk
add-ins of all technicians are able to access the files from their systems on the network.

Attachments to include in case completion notification - And likewise, you can configure Team Helpdesk add-in to
include certain documents when sending out the automated email about case closure to the caller.
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NOTE: Such document files should be placed on a network shared folder e.g., \\Server\File so that, Team Helpdesk
add-ins of all technicians are able to access the files from their systems on the network.
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Associated Users Alerts

Often a helpdesk may have the requirement to link certain stakeholders, apart from the caller, to a support case. These can be
external vendors, contractors or secondary field technicians whose inputs or contributions are required in resolving the case.
In Team Helpdesk, we refer these stakeholders as ‘Associated users’ and these can be added to a case, either by choosing
from contacts in your Address Book (or Global Address List - GAL).
Alert associated users with caller specific automated notifications
Enable this option to also notify any associated users of a case with the same set of notifications that are send to
the caller.
Alert associated users with technician specific automated notifications
Enable this option to also notify any associated users of a case with the same set of notifications that are send to
the assigned technicians.
BCC associated users when responding to caller through ‘Email to Caller’ template
Enable this option so that any associated users of a case also receive a copy of the email communication that is
send to the caller by the technician through the ‘Email to Caller’ button of the case form in Outlook.
BCC associated users when replying to caller
Enable this option so that any associated users of a case also receive a copy of the email reply that is send to the
caller by the technician in Outlook.
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BCC associated users when responding to technician through ‘Email to Technician’ template
Enable this option so that any associated users of a case also receive a copy of the email that is send to the
assigned technician through the ‘Email to Technician’ button of the case form in Outlook.
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Group Alerts

Alert the following users when a new case is generated
When enabled, with this feature, helpdesk manager can specify users or stakeholders that are to be notified once
a new case is generated. Clicking the 'Choose...' button would allow selection of the contacts from the address
book/Global Address lists etc.
NOTE: If multiple users are specified, each email address is separated by a semi colon.

Alert the following users when a case is closed
When enabled, with this feature, helpdesk manager can specify users or stakeholders that are to be notified when
a case is completed and closed. Clicking the 'Choose...' button would allow selection of the contacts from the
address book/Global Address lists etc.
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NOTE: If multiple users are specified, each email address is separated by a semi colon.
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Admin Notifications

Managers list
Specify technicians that will be designated as helpdesk managers and add them to the list. If defined, such
managers will be notified with administrative specific alerts as well as other notifications on case.
Specify an administrator from among the technicians who will receive system based alerts
From the list of managers, choose one who will receive these three system alerts (3), (4), (5).
Automatically alert the administrator when an email is received on a non-existent case in the monitored
folder/mailbox
Enable this option so that helpdesk add-in can send a notification to the administrator informing about a nonexistent case, when a reply to a non-existent case is received from the caller in the monitored list of
folders/mailboxes.
Automatically alert the administrator when one tries to generate a case from an email of unlisted domain
Enable this option so that helpdesk add-in can send a notification to the administrator if a technician tries to raise
a new case from an email that is not from the administrator approved list of domains.
NOTE: Approved domains can be defined under Team Helpdesk Manager > Callers List > Company tab
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Automatically alert the administrator when an email fails to get processed (which then is moved to the
conflicted email subfolder)
Enable this option so that helpdesk add-in can send a notification to the administrator when it failed to create a
case from an email, or failed to add a reply from the caller to the associated case.
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Configure Alerts Workflow

Alert on ‘Due Time’ lapse should be sent to technician
When the due date of a case approaches or is about to be lapsed, you can specify how and when Team Helpdesk
add-in should notify the assigned technicians (of the case).
For instance, if you want the add-in to notify the technicians only after the due date has lapsed, then choose the
first option ‘On Lapsed’.
On the other hand, if you want the technicians to be warned well before the due date is about to be lapsed, then
choose the second option ‘When it is about to lapse in’ and specify number of hours before such notifications are
to be sent to the technicians.
Alert on ‘Response Time’ lapse should be sent to technician
When the respond by date of a case approaches or is about to be lapsed, you can specify how and when Team
Helpdesk add-in should notify the assigned technicians (of the case).
For instance, if you want the add-in to notify the technicians only after the respond by date has lapsed, then
choose the first option ‘On Lapsed’.
On the other hand, if you want the technicians to be warned well before the respond by date is about to be
lapsed, then choose the second option ‘When it is about to lapse in’ and specify number of hours before such
notifications are to be sent to the technicians.
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Force Send/Receive action to immediately start the automated email delivery
When this is enabled, the add-in will bypass the Outlook queue to immediately start delivering any automated
email notifications. Only use this feature if your Outlook is taking time to deliver emails from the Outbox.
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Include attachments from the case to automated notification email
If enabled, the add-in will include copies of the attachments, if present in the case item, into the automated
notification emails.

Allow technician to edit the newly generated case (from email) before sending the automated alerts)
By default, when generating a case from an e-mail (through the 'Convert to Case' button), the add-in assigns a new
ID and accordingly, the allotment and technician notification e-mails are sent instantly.
However, if your helpdesk workflow requires that the technicians add more information to the new case, like an
attachment or caller address etc., before the add-in can send out the automated notifications, you can enable this
option. When enabled, the helpdesk add-in would display the newly generated case instantly allowing the
technician to alter/add information such as custom fields, attachments or assigning it to another technician, for
example. Only when the technician clicks 'Save' button, the add-in will assign a new ID and send out the
notification to the caller/assigned technicians.
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Don't use default template in replies made from case form
If enabled, when technician clicks the 'reply to last email' button in the case form and no recent replies from the
caller exists, the add-in will use a blank template instead of the ‘Email to Caller’ template.
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4.14 Advanced Options
With the advanced options, helpdesk administrators can control and streamline how technicians interact and complete cases
in Outlook.

Only process incoming emails from existing caller lists
Check this option to only process support requests coming from callers that already existed in the Team Helpdesk callers
list. Any emails from outside the caller list are simply ignored by the add-in. For monitored folders and mailboxes, emails
that are not from the callers list are moved to a subfolder 'Unprocessed Emails'. Please note that, to use this feature,
technicians would need to have a higher permission (such as Publishing editor or owner) over the monitored mailbox or
folder. By default, this option is disabled.
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You can compile a list of your callers in Team Helpdesk Manager > Callers List.
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Only process incoming emails from domain names listed under companies list
By default, helpdesk add-in can raise support cases from any emails. However, if your support policy is only confined to
customers from known or trusted companies or domains, you could configure Team Helpdesk to only process helpdesk
related activities and workflow from emails sent from admin specified domain names. And emails from outside the
trusted domains would be skipped. To implement this selective processing policy, the manager needs to define such list of
trusted domains under Team Helpdesk Manager > Callers List > Company tab.

So, when you or other technicians try to generate a new case from an email send from an unlisted domain, Team
Helpdesk would not process and instead a popup message would be shown that the email sender domain is not trusted.
And if Team Helpdesk Manager add-in was monitoring a mailbox (support account for example), and when a new email is
received from unlisted domains (e.g., not in the Team Helpdesk Manager > Company list), the email would be moved to a
subfolder called 'Unlisted Domain Emails' for your references.
Allow assignment of multiple technicians to a case
Enable this option to allow assignment of a support case to multiple technicians so that each technician can chip in and
contribute to the resolution of the issue. By default, only a single technician is allowed per case.
Allow multiple conversion of Outlook items to support cases in a single click
To increase productivity, this option enables a technician to convert multiple selected Outlook items such as emails,
appointments or tasks to support request cases in a single-click. Use the 'Convert to case' button to achieve this. By
default, Team Helpdesk processes a single email to support case, no matter how many emails were selected.
Allow multiple cases operation (Delete/Print/Resolved/Create KB) in a single click
This option enables a technician to batch-process any support case specific operations such as marking as resolved,
deleting, printing, re-opening etc. on multiple support cases. By default, Team Helpdesk processes a single support case
when such operation is initiated.
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Allow technicians to edit the time stamp when editing time spent
By default, the time stamp of any time spent entries made in a case by technicians are read-only. That is, once a entry is
made, the technician can’t change the time stamp, though they might be able to edit the time spent value.
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But if you want to allow your technicians to edit the time stamp of the time spent entries made on cases too, enable this
option. And the ‘Edit Time’ dialog box will allow technicians to pick a date and override the existing one.

Do not send notification to caller if no technician is assigned to the case
Enable this option so that the add-in skips sending automated notifications to caller if the allotted case has not been
assigned a technician.
Default language of the user interface (UI)
Team Helpdesk add-in supports the following languages: English, Español, Norwegian, Danish, Dutch, Deutsch, French,
Finnish, Swedish, Portuguese.
Choose a language from the drop-down to use with Team Helpdesk add-in in its User Interface (UI).
NOTE: This setting will only take into effect once your restart Outlook.
Check which hourly rate to use for calculating the cost of supporting the case in statistics
Specify which hourly rate to use in statistics in calculating cost - technician rate, problem rate, department rate or
company rate. This is useful if the organization use hourly rate to pay technicians.
NOTE: To add or modify the hourly rate, refer below
For technician rate: Team Helpdesk Manager > Technicians List > Hourly rate
For problem rate: Team Helpdesk Manager > Problems List > Categories
For department rate: Team Helpdesk Manager > Callers List > Departments
For Company rate: Team Helpdesk Manager > Callers List > Companies
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Show Duration in reports as
When you run reports or statistics, you have a choice to display duration fields (such as Open Duration, Resolution
Duration, Response Duration, Elapsed Duration) in either Days, Hours or Minutes.
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Configuring Outgoing Accounts

In Team Helpdesk Manager > Advanced Options > Outgoing Accounts tab, you can specify which mailbox account would Team
Helpdesk add-ins use to send out the automated notification alerts and replies to callers and technicians.
When you select the first option 'None', Team Helpdesk will use the default/primary mail account that is
configured on the Outlook profile to send out the alerts and replies. You should use this option if you want each
technician to send out the auto-alerts and replies from their associated default account.
However, if you want a centralized or single account to use for all outgoing emails and alerts, choose the second
option 'Use this particular account'. This is ideal if you have a common account (e.g., support@yourdomain.com)
and you want the replies and auto-alerts received by the caller to appear to come from this common account (in
the from field of the email) no matter which technician is replying/sending those alerts/emails from their Outlook.
Note: To work with this feature, the helpdesk manager has to explicitly grant 'Send on behalf' of rights to the
technicians. You do that from the windows server: Active Directory Users and Computers > Common account >
Properties > Exchange General > Delivery Options.
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When both 'Send As' and 'Send Behalf of' are enabled, the add-in will try to use the 'Send As' permission as first
preference. If that fails, it will fall back to using 'Send behalf of'.
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The last option is to configure Team Helpdesk to send out notification emails and responses, using the 'Original
Email recipient mailbox account'. For example, assume you have two mailboxes, Support and Sales. And you
receive support request email, say email A, to Support mailbox, and email B, to Sales mailbox. When Team
Helpdesk processes and generates a case from each of these emails (either manually or automatically), Team
Helpdesk will use the recipient account, for sending out the notification emails. So, when sending notification

email to Caller A, Team Helpdesk will send it from Support account. i.e., the from: field of the email will have
Support address, as the sender. Likewise, when sending notification email to Caller B, it will be sent from Sales
account. i.e., the from: field of the email will have Sales address.
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NOTE: You and other technicians, still need to have 'Send behalf' permission over the Support and Sales
mailboxes. Otherwise, you will receive an error response from your Exchange Server, regarding inadequate
permission to send email from that particular account.
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KB Settings

Sometimes, you might have requirements to create KB articles that deals with non-support issues. You can mark such articles
as ‘private’ to differentiate it from other KB articles. In Team Helpdesk Manager > Advanced Options > KB tab, you can specify
additional options to deal with private KB articles.
Do not show private KBs in ‘Reply with KB’ dialog box
Enable this option to hide private KB articles from appearing in the ‘Reply with KB’ dialog box (to prevent
technicians from accidentally using private KB articles to reply to emails).
NOTE: ‘Reply with KB’ option button is located under Outlook > Helpdesk toolbar in your Inboxes.
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Do not publish private KBs to Web
Enable this option to exclude private KB articles from being published to the online KB module of Customer Web
Service (CWS) site.
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4.15 Automation Options
With the Automation Options, administrators can configure the helpdesk system for on-the-fly assignment of technicians
and due dates on new cases, set email processing workflow, add reminders to technician’s calendar – and increase
productivity of the helpdesk.

Due Date for newly created cases
Specify how the due date of newly created support cases should be assigned.
a) Assign current Date/Time – Choose this option to set the current date/time (e.g., same as when the case was
created)
b) Schedule – Choose this option to schedule ahead it. You need to input the number of hours or days that will be
scheduled ahead for the due date of the new case
c) Assign the current or next available Working Hour – Choose this option to dynamically seek the next available
working hour (as per helpdesk availability e.g., starting and closing hours).
d) None – Choose this option to have empty due date on the new case.
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Respond by date for newly created cases
Specify how the respond by date of newly created support cases should be assigned.
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a) Assign current Date/Time – Choose this option to set the current date/time (e.g., same as when the case was
created)
b) Schedule – Choose this option to schedule ahead it. You need to input the number of hours or days that will be
scheduled ahead for the due date of the new case
c) Assign the current or next available Working Hour – Choose this option to dynamically seek the next available
working hour (as per helpdesk availability e.g., starting and closing hours).
d) None – Choose this option to have empty due date on the new case.

Configure Email post processing workflow

Once a case is raised from an email using the ‘Convert to Case’ button (Manual conversion), choose if you
want to move the original email or its copy (from which the support requests were logged from) to the Team
Helpdesk Email History folder. If you want to preserve a copy of the support request email in the Inbox
permanently, choose the first option ‘Leave the original email intact’ so that you and others will continue to have
access to that email.

If the case was raised automatically from an incoming email in a monitored Inbox, choose if you want to
move the original email or its copy (from which the support requests were logged from) to the Team Helpdesk
Email History folder. If you want to preserve a copy of the support request email in a subfolder permanently,
choose the second option ‘Leave a copy of the email under ‘Processed Emails’ subfolder’ so that you and others
will continue to have access to that email.

When the helpdesk add-in encounters an email from the caller (that contains a Case ID in the subject), and if the
particular case ID does not exist in Team Helpdesk Ongoing/Resolved Cases folders (say, it was deleted
permanently, specify the alternative option the helpdesk add-in should do with that particular email.
Choose ‘Generate a new case from the email’ (first option) so that the add-in will ignore the reference of the nonexistent/invalid case ID and instead raise a new case from the email to generate a new case ID.
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Choose the second option, to configure the add-in to move the email that contains the invalid Case ID reference to
the ‘Unprocessed Emails’ subfolder. And administrators can later on decide what to do and deal with it.
Additionally, you can also allow the add-in to send an auto alert to the administrator informing about this email
with invalid ID.
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Technicians Workflow

Enables Team Helpdesk to add/update an appointment into the concerned technician's mailbox calendar when
the helpdesk managers assign/change the due date on a support case. Any change in the due date of that case at a
later stage will be automatically updated to the existing appointment in the mailbox. This appointment is removed
when the corresponding case is closed.
The Team Helpdesk due date appointments appear in
summarized form on the main 'Outlook Today' page
when the technician starts Outlook. This way, the
technician gets to know which new cases are being
assigned to him/her
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In the default calendar, the due date appointments
appear as any other appointment. The case number and the subject of the assigned case in the appointment
subject differentiate it from other personal appointments.
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When the due date appointments are about to be overdue, Outlook automatically displays reminders popup to
the technician. This way, the technician is alerted about the pending cases which need his/her attention.

The details of a due date appointment added from Team Helpdesk to the technician's mailbox calendar:
•
•
•
•

the case number and case subject are available in the appointment' subject
the due date of the case is the same as that of the start time and end time of the appointment
In the appointment description field, there is a link to the actual case, clicking which would open the case
from the Team Helpdesk 'Ongoing cases' folder.
The appointment description also informs the technician about the caller, and a summary of the problem
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Enabling this option also allows helpdesk managers and other technicians (provided they have permission to
access your mailbox) to lookup your personal calendar so that the helpdesk manager can assign a particular due
date on which you are available to work on the case.
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Enables Team Helpdesk to add/update a task into the responsible technician's mailbox task folder when the
helpdesk managers assign/change the due date on a support case. Any change in the due date of that case at a
later stage will be automatically updated to the existing task in the mailbox. This task is removed when the
corresponding case is closed.
Enables Team Helpdesk to maintain a schedule calendar for each technician such that
all due date of support cases is listed in corresponding calendar (bearing the
technician's name).
When due dates are assigned or changed in support cases, appointments are added or
updated in these calendars. The purpose of these calendars is to allow helpdesk
managers or other technicians to lookup these calendars for a suitable schedule such
that the assignment of due date take into the consideration other assignments which
may already existed for that particular technician. This will help prevent due date
clashes and increase efficiency of the helpdesk staffs.

Enable this option if you want Team Helpdesk to automatically assign the default technician (specified for a
particular caller in the callers list) to a support case (which is logged from an email sent by a caller that exists in the
Team Helpdesk callers list). By default, this option is enabled.
Enable this option if you want Team Helpdesk to auto-generate a random password for any addition of a new
caller to the callers list. By default, this feature is enabled.
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Enable this option if you want Team Helpdesk add-in to automatically assign the current technician to the
new case generated from an email automatically
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Automatically add new technician to the Technicians List
Enable this option to auto add first time new technician to the Technicians List of the helpdesk database.

Make Mobile as the primary contact number
Enable this option to force helpdesk add-in to use mobile number of the technician (over phone) when dialing calls
to technicians from the case form or Team Helpdesk contact manager panel.
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NOTE: This is applicable only if each technician had enabled phone calls with Skype in Outlook > Team Helpdesk
toolbar > Settings > Personal Settings > General tab.
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Other Automation Settings

Automatically generate a random password for new caller
If enabled, when a new, first-time caller is encountered, the helpdesk add-in will automatically generate a random
password for Caller Web Access website for that new caller before adding that caller to the Team Helpdesk >
Callers List.
NOTE: The Caller Web Access (CWA) site, which is a part of the Customer Web Service (CWS) site, requires a user
credential for caller to access their support cases online. Helpdesk managers can define this credential (e.g.
password) in the Team Helpdesk Callers list dialog.
Automatically add first time caller to callers list
If enabled, when a new first-time caller seeks support request (when they send an email to support), the helpdesk
add-in will automatically add it to the list of callers in helpdesk database, for future use.
Automatically add new problem to Problems list
If enabled, when a new problem category or type (that does not exist in Problems list yet) is entered by the
technician in the case form in Outlook, the helpdesk add-in will automatically add it to the list of problems in
helpdesk database, for future use.
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Allow color coding of case items based on the status of the case
If enabled, when you set the status of the case or when the add-in does that automatically using the default status
values set for various events, you will see that the categories column of the case item has color-coded status
(which you can define for each status under the column 'Color Code' in Team Helpdesk Manager > Problems List >
Statuses List).
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If your technicians have added new cases manually in SharePoint through the web browser, such cases are not
synced back to the Team Helpdesk Ongoing/Resolved Cases folders in Outlook i.e., copies of such cases are not
available in Outlook. If your technicians want to make copies of such cases (e.g., sync back) in Outlook, they would
do that via the 'Retrieve Cases from SharePoint' tool (available in Agent add-in and located under Outlook >
Ongoing Cases folder > Ongoing Cases toolbar).
Alternatively, this feature can be automated via the Team Helpdesk Manager add-in i.e., Outlook with Team
Helpdesk manager add-in will automatically check for new cases availability in the SharePoint list and generate
copies in Outlook on the fly. To enable it check the option 'Automatically bring newly added cases in SharePoint to
Team Helpdesk folders in Outlook'.
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Further, you can set the interval the add-in would check for the new cases in SharePoint. Additionally, you can also
allow the add-in to send out the case allotment notification to caller, case assignment notification to technicians.
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4.16 Case Options

Allotment Template for new case
If you have defined more than one allotment templates, choose a default allotment template that will be set
automatically on newly raised cases. For more on Allotment Templates, refer to Team Helpdesk Manager > Templates
Manager > Allotment Templates.
Problem Category of newly generated case
Choose a particular problem category from the drop-down list that will be used as default value for Problem Category
field on newly raised case. To add new problem category, refer to Team Helpdesk Manager > Problems List > Categories
tab.
Problem Type of newly generated case
Choose a particular problem type from the drop-down list that will be used as default value for Problem Type field on
newly raised case. To add new problem type, refer to Team Helpdesk Manager > Problems List.
Status of newly generated case
Choose a particular status from the drop-down list that will be used as default value for status field on newly raised case.
To add new statuses, refer to Team Helpdesk Manager > Statuses List.
Status of Resolved/Completed case
Choose a particular status from the drop-down list that will be set to a resolved/completed case.
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Status of Re-opened case
Choose a particular status from the drop-down list that will be set to the reopened case.
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Status of case on reply send to the caller
Choose a status from the drop-down list that will be set to the case once a reply is successfully send to the caller.

Status of case on reply received from the caller
Choose a particular status from the drop-down list that will be set to the case after a reply is received from the caller.
Status of due date lapsed case
Choose a particular status from the drop-down list that will be set to the case on due date lapsed.
Status of case on SLA breach (on Due time lapse)
Choose a particular status from the drop-down list that will be set to the case on SLA breach of Due Time.
Status of case on SLA breach (on Response time lapse)
Choose a particular status from the drop-down list that will be set to the case on SLA breach of Response Time.
Status of newly assigned case
Choose a particular status from the drop-down list that will be set to the case just after assigning to a technician.
Status of respond by date lapsed case
Choose a particular status from the drop-down list that will be set to the case on respond date lapse.
SLA for new generated case
Choose a Service Level Agreement (SLA) value from the drop-down list that will be applied by default on any newly
generated case. For more on SLA, refer to Team Helpdesk Manager > Service Level Agreements.
SLA for re-opened case
Choose a Service Level Agreement (SLA) value from the drop-down list that will be applied to a case on re-opening. For
more on SLA, refer to Team Helpdesk Manager > Service Level Agreements.
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When a problem type is chosen from the drop-down field in the case form, you can configure if the helpdesk add-in will
also automatically apply the Technicians and Service Level Agreements (that are default and associated with the chosen
Problem Type) to the case. You can choose default technicians and SLA for each problem type under Team Helpdesk
Manager > Problems List.
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When a caller is chosen from the drop-down field in the case form, you can configure if the helpdesk add-in will also
automatically apply the Technicians, Service Level Agreements and Associated Users (that are default and associated
with the chosen caller) to the case. You can choose default technicians, SLA and Associated Users for each caller under
Team Helpdesk Manager > Callers List.
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Case ID and Prefix Code
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Append Prefix Code in Email Subject
Enable this option so that the helpdesk add-in will add a prefix code before the case ID (under subject field) of the case or
to the outgoing emails. You can choose which prefix code to use from one of the following fields:
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•

Technician Code – You can define prefix code for each technician under Team Helpdesk Manager > Technicians
List.

•

Problem Category Code – You can define prefix code for each category under Team Helpdesk Manager >
Problems List > Categories List tab.

•

Problem Type Code – You can define prefix code for each problem type under Team Helpdesk Manager >
Problems List.

•

Department Code – You can define prefix code for each department under Team Helpdesk Manager > Callers List
> Departments tab.

•

Company Code – You can define prefix code for each company under Team Helpdesk Manager > Callers List >
Company tab.

•

Global Code – You can define one global, fixed prefix code that will be used in all cases and email
communications within the helpdesk.
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For instance, you can choose ‘Use Technician Code’ so that the helpdesk add-in can insert the prefix code of the assigned
technician in the subject of the case and emails.
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Alternatively, you can also define a global fixed code that would be prefixed in all the cases. By default, adding prefix
code before the case ID in the subject of the email is disabled.
What are the benefits? By adding a prefix code to the subject of the case or on outgoing emails, when callers reply back,
the received emails would contain the same prefix code. And this in turn may aid in quick recognition of the particular
case, by simply looking at the prefix code.
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For instance, if the department code is set as the prefix code, you and other technicians can easily recognize that a
particular reply belongs to a specific department. Likewise, if the technician code is set as the prefix code, you can easily
recognize who is responsible for attending to the reply or the case. Moreover, it is easy to differentiate important emails
from the less trivial ones.

Back to TOC

Insert Case ID and Prefix in the subject of the related original email
Enable this option so that the helpdesk add-in would embed prefix code and Case ID into the subject of the original email
just after a case is successfully raised from that email.

Don’t process emails with invalid/non-existent prefix code
When the add-in tries to add/update a possible reply (that contains a number enclosed in square brackets) to its
corresponding case, enabling this option will skip processing those emails that do not contain a valid prefix code in the
subject.
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Placement of Case ID/Prefix code in subject
Choose if the prefix/code (enclosed in square brackets) is to be placed at the beginning or end of the subject line. By
default, the prefix code/ID is placed the beginning of the subject.
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Consolidated Conversation and Emails Threading

Most support cases cannot be closed within a single e-mail and response. Feedback from the caller and suggestions from the
respective technicians often occur over multiple request-response emails. Moreover, different members from the support teams
may provide resolutions during the course of the request. So, in practical scenario, a support case might have various e-mail
versions of the resolution steps, making it cumbersome to get a complete picture of responses and resolution.
With the conversation threading feature, Team Helpdesk captures the complete course of the conversation chronologically, from
all email communications received or sent (including those automated notifications sent to caller and technicians in due course).
The end result is a consolidated view where all the responses to a support request are collated together. Redundant and repeated
conversations are filtered out to present only the relevant communications. This eases the task of the helpdesk and minimizes
repeating what has already been done, while keeping support team members to stay on the track. Another advantage is it allows
the technician to quickly glimpse through the thread and get a complete overview on the responses in chronological order and
resolution applied to the particular support request, something which is hard to extract from viewing multiple email responses.
Choose if new conversation to the case is to be added on top or below of existing consolidated conversations.
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Add header entry in the consolidated conversation for automated notification sent
Enable this option to embed a snippet entry of the automated notification or alert sent to the caller or technicians by the
helpdesk add-in.
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Link Header entry in consolidated conversation to actual mail item
Enable this option so that the added conversation snippet is hyperlinked to the actual email item (so that it is clickable
and allows for quick access to the linked email without searching for it).
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Transfer attachments from email reply to case item
When processing incoming replies (that contains attachments) from caller, enable this option so that the helpdesk add-in
will also automatically add these attachments from email to the case item.
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Optionally, you can enable the option ‘Add entries of new attachments in the conversation’, so that a new snippet entry
on the attachment names (which were added to the case) are included to the conversation.
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Add notes to consolidated conversation
Enabling this would add a copy of the private note (that is added from the Notes tab of the case form) to the conversation
threading (body field), which is then visible even when the case is previewed in Outlook Explorer window when selected.
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Helpdesk Fields Workflow

Mandatory fields that are required to be filled out for marking a case as resolved
Enable this option to set certain helpdesk fields as mandatory to be filled, before the case can be marked resolved or
complete. And select the fields that are to be made mandatory.
NOTE: Mandatory fields will be shown in red labels in the case form.
Hide Case form sections/tabs
Helpdesk manager can choose to hide certain portion of the Outlook case form, such as the Time Spent, Email History,
Notes section etc. if these sections or tabs won’t be used at all. And this setting would affect all technicians. For
example, below is how the case form appears when none of the sections/tabs are hidden.
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And below is the case form with ‘Related Cases’, ‘Associated users’, ‘Logs’, ‘Notes’ and ‘Related KB Articles’ tabs
hidden.
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Limit user from entering their own value in the following drop-down fields
Check the particular drop-down fields that you only want technicians to be able to choose from the drop-down and
prevent entering their own. By default, technicians can input their own value against the available drop-down list. To
prevent non-existent value from being tagged to the case for these drop-down fields, check the corresponding field.
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NOTE: drop-down fields with limitation in case form are greyed out, where ones without limitation are not (white
back-color)
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Logo and Case Form

Substitute the logo with your own
To use your own company logo or brand in the case form, you can specify an image file (JPG, GIF, PNG) located on a
network shared folder. Or, alternatively, you can use an image file located on the web.
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And when you open and view the case form in Outlook, your company logo you specified above should show.
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NOTE: Make sure you use an image path that is accessible to all technicians from their systems. This means, you can
either make sure of an image file that is located on a shared network folder (e.g., \\Server\files\logo.gif) or an image from
the web (e.g., www.company.com/logo.gif)

Data loading behavior in the case form
By default, helpdesk add-in implements ‘on-demand’ loading of the data in the case form for performance i.e., it will load
the data for the case section/tab as and when you click and navigate to it. However, with the second option, you can
overwrite this workflow to force the helpdesk add-in to load all data concurrently at once in all sections and tabs of the
case form. Note that, with this approach, the performance might take a hit and the case form might take longer time to
load and show.
Prompt me if to customize the auto alert for Case Closure
Enable this option to force the helpdesk add-in to prompt the technicians for confirmation on case closure as well as to
choose if to send the auto notification to the caller. If yes, the technician can choose to customize the notification (say, if
further information specific to that ticket or caller are needed to be added before it is finally send).
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Prompt to add Time Spent when closing the case form
Enable this option to force the helpdesk add-in to prompt the technician to add their time spent data to the case when
the form window is closed.
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Other Case Options

Automatically update caller information from the case
form to the Callers List
If enabled, the helpdesk add-in will track the changes in
the caller information in the cases and if required, will
make the necessary update back to the Team Helpdesk
Manager > Callers List if any of the caller information
was changed or added in the case.
For example, when a caller seeks support request the
first time, the helpdesk may only have the caller email
and name in the callers list database.

Page

97

However, after iteration of communication or calls, if the caller information was updated to the case to include say,
phone number, mobile number, address, company etc., the helpdesk add-in will automatically track and update the
caller information back to the Callers list database for future use.
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Include CC users in the notification email sent to the caller when a case is generated from an email
If enabled, when a support case is first generated from an email, helpdesk add-in will send out the case allotment

notification email to the caller, as well as to the recipients specified in the CC field of the original email. The benefit is to
allow anyone (on the CC line) to respond to the ticket thread without creating a new ticket.
Automatically view the case that was re-opened in its inspector window
Enable this option to force helpdesk add-in to display the case in its window when it is re-opened from completed state.
This is applicable and handy if you had re-opened the cases from the search panel or from the Outlook explorer window.

Don't reopen a closed case automatically
There may be situations where the caller just replied to say, thank you for the support. But that may trigger a reopening
of the case with unnecessary overhead. Enable this option to prevent the helpdesk add-in from automatically re-opening
a case from its completed state when a response from the caller is received by the helpdesk after the completion of the
case. This will also prevent the add-in from adding redundant and irrelevant information to the closed case.
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NOTE: If enabled, closed cases won’t reopen automatically when a customer sends a reply after the case is closed. This
way it is very easy to miss the reply of the customer because the case stays in closed issues. Technicians would have to
manually re-open the case (if they deem fit) after analyzing the response from the caller i.e., if the caller just replied to
say, ‘Thank you for the support’, you can ignore the escalation.
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Automatically assign technician associated with the sender's email domain name to the new case
If enabled, helpdesk add-in will automatically assign default technician to a case based on the sender's domain address
e.g. sender@somecompany.com

NOTE: You can add company details under Team Helpdesk Manager > Callers List > Company tab. And add
somecompany.com in the domain column and also specify default technicians for that company.
By default, check the 'Disable Notifications to caller' option on newly generated cases
Sometimes, on specific cases or caller, you may want helpdesk add-in not to send auto notifications on activities or
events of the case. So instead of disabling a particular auto-alert at the global level, you can choose to disable auto-alerts
on per case. Enable this option so that by default, notifications are turned off to caller for new cases.

By default, check the 'Disable Notifications to technicians' option on newly generated cases
Likewise, on specific cases or technicians, you may want helpdesk add-in not to send auto notifications on activities or
events of the case. So instead of disabling a particular auto-alert at the global level, you can choose to disable auto-alerts
on per case. Enable this option so that by default, notifications are turned off to assigned technicians for new cases.

If a problem type exists in the email subject, automatically assign it and related default values to the new case
If enabled, the helpdesk add-in will automatically search for the existence of any problem type keyword in the subject of
emails. If exists, it would auto-assign the default values of the technician, SLA or problem category fields (based on the
admin enabled fields) to the case that are associated with the particular problem type.
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For example, here is a problem type ‘iPhone’ in the Problems List, which belongs to ‘Mobiles’ category and default
technician is ‘Aaron Beit’, and default Service level is ‘SLA 3’ and default Zone (custom problem field) is ‘East Zone’.
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And assuming a customer sends an email to helpdesk with problem type ’iPhone’ keyword in the subject.

When a case is raised from this email (manually or automatically), the helpdesk add-in will sense the presence of a
problem type keyword (e.g. iPhone). And it’s intelligent enough to auto assign the default technician and service level
(SLA) associated with this problem type. This will in turn trigger a notification alert to the assigned technician as well as to
the supervisors (if the specific alerts are enabled in Team Helpdesk Manager > Notification Options > General Alerts tab).
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When importing caller info from GAL, use the value of the address from – Street field or Office location field
With this feature, when choosing a caller from the address book, you can instruct the add-in which location field of the
contact in Global Address List (GAL) would be used to populate the Address field of the Caller in the Outlook Case form.
You can choose the Street field of the contact, or the Office location. Default is the Street field.

Back to TOC

Show Time Spent in – Minutes or Hours
You can set helpdesk add-in to display the time spent on a case as minutes or hours. Default is in ‘Minutes’.
If the 'Hours' option is selected, the add-in will display the total time spent on a case in HH:MM format.

Show non-due date appointments when browsing the calendar
Helpdesk managers who assign due date to cases can look up the technician's personal mailbox calendar for time
availability and schedules from within the Outlook case form. By default, only the due-date specific appointments in the
calendar are visible to due date assigners.
Enable this option to show all appointments (e.g. personal appointments) available to the assigners when the
technician’s calendar is accessed for schedule availability chart from within the case form.
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NOTE: This feature only works when the manager has enabled 'Automatically add due date appointment into the
technician's mailbox calendar' in Team Helpdesk Manager > Automation Options > Technicians tab and that the
particular managers/technicians has permission over the assigned technician's mailbox or calendar.
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4.17 Upgrade Options
With this feature, when a new updated version of Team Helpdesk is available, you can perform upgrade of the Team Helpdesk
agent add-in on each technician’s system automatically. If enabled, it checks for new version availability at Outlook startup.

Auto-check of new version from www.assistmyteam.com and offer to install if a new version is available
Check this option to enable automatic check of new version of the Team Helpdesk Agent add-in from the product
website at www.assistmyteam.com during Outlook startup. If a new version is available, you will be prompted if
you want to open the download page.
Controlled Upgrade – from an admin specified network folder
Check this option to enable automatic upgrade of Team Helpdesk Agent add-in from a network path, which is
specified by the administrator. In the text box, specify the network shared folder where the Agent setup files
(TeamHelpdeskAgentSetup_xXX.exe and VersionInfo.txt) are placed. When new versions are available, all you need
to do is download the latest version from the Team Helpdesk download page
(www.assistmyteam.net/TeamHelpdesk/Download.asp), and then place the TeamHelpdeskAgentSetup_xXX.exe
and VersionInfo.txt into this network folder.
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Display a message to the member on new version availability - This would display a message about new version
availability if one is found.
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4.18 Service Level Agreements (SLA)
A service-level agreement (SLA) is a contract between a service provider such as a company helpdesk and a customer that specifies,
usually in measurable terms, what services the provider will furnish. It is now widely accepted that service provision and receipt
should be governed by an agreement. This is essential to define the parameters of the service, for the benefit of both the provider
and the recipient. More importantly, it should have a guaranteed response or resolution time for incidents (trouble tickets). For
example, a SLA between Webhosting Company and its customers could be –2 hrs. response time. In Team Helpdesk, Service Level
Agreement (SLA) is designed around two dimensions ‘Response Time' and 'Due Time'.

Response Time - duration within which the assigned technicians of the case should have responded to the caller for the
first time (after the case was logged). When a SLA is enforced to a case, the response time of that SLA would be adjusted
(added) to the 'Respond by Date' field. If the case was not responded within the stipulated SLA response time, a SLA
breach (i.e., a response time lapse) would occur and an automated notification would be sent to the supervisors.
Due Time - duration within which the assigned technicians should have closed (mark complete) the case. When a SLA is
enforced to a case, the due time of that SLA would be adjusted (added) to the 'Due Date' field. If the case was not closed
i.e., mark competed) within the stipulated SLA due time, a SLA breach (i.e., a due time lapse) would occur and an
automated notification would be sent to the supervisors.
Helpdesk Service Hours - Enables managers to specify the service days and hours their helpdesk operates. With this
mechanism, any automatic assignment of response by date or due date to support cases, including those triggered by an
enforced Service Level Agreement (SLA), would be dynamically adjusted to fall within the service days and hours. By
default, service day start from Monday and ends at Saturday. You can choose the service starting and ending days as per
your helpdesk requirement.
Once a service days and hours are specified, respond by date or due date assignment will take note of the helpdesk
unavailability accordingly. When specifying a SLA to a support case, the response time or due time would be added to
the current date/time, plus any helpdesk off-hours such that, the response by date or due date is always set within the
service hours band. So, no longer you or other technicians would be sent respond by date or due date lapse or SLA
breach automated alerts in off hours of the helpdesk.
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Team Helpdesk System allows helpdesk managers to set and maintain SLA standards in the organization. Within the Outlook case
form, managers can enforce or change a SLA on a support case based on escalation requirements. Additionally, SLAs can be assigned
automatically to newly created cases. For example, in Customer Web Service (CWS) website, end-users submitting support request
via a webform would select a problem category and type along with other information. When the submitted support request is
processed in Team Helpdesk in Outlook, the default SLA specified for that combination of Problem Category and Type fields is
enforced to the case.
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As a support case approaches an SLA Management breach, the case item appears red in the Outlook view, as well as escalation
alerts, either as email or SMS message are sent out to the concerned technicians and supervisors. This prevents any issue or request
from ever falling through the cracks and allows your team to effectively stay on top of any support cases approaching the breach of a
Service Level Agreement.

SLA Supervisors
To keep a tap on timely resolution of cases, the manager can enable notification alerts to supervisors when new cases are
generated, or when new technicians are assigned or when there is a SLA breach etc.

With the first option 'Use Supervisors specific for each Technician', you can define supervisors for each technician in
Team Helpdesk Manager > Technicians List panel.

And when a case triggers a SLA breach, the supervisors defined for that assigned technicians (above) will be notified for
escalation.

Page

104

With the second option 'Common Supervisors for all technicians', you can use global fixed supervisors, so that for every
SLA breach, the same set of supervisors are notified.
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SLA Calculation

By default, when a SLA is applied to a case, the helpdesk add-in calculates the ‘respond by date’ field by computing the
SLA response time to the current date/time. But you can change that so the SLA response time is applied to the request
received time of the email, or date/time when the case was generated or simply added on top of an existing ‘respond
by date’ (if it is not empty).
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By default, when a SLA is applied to a case, the helpdesk add-in calculates the ‘due date’ by computing the SLA due time
to the current date/time. But you can change that so the SLA due time is applied to the request received time of the
email, or date/time when the case was generated or simply added on top of an existing ‘due date’ (if it is not empty).
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4.19 Mobile Messaging
Short Message Service or SMS, is used by billions of people and is the most pervasive use of data on mobile phones. SMS is
convenient and cost effective for a number of reasons. When compared with the cost of airtime for voice calls or wireless web
access, SMS is a real bargain and messages are immediately delivered directly to your phone. Team Helpdesk system supports
dispatching automating alerts to mobile devices of the callers or technicians in the form of SMS messages.
Team Helpdesk supports sending SMS messages using two different technologies/platforms - Skype and HTTP SMS gateway.

Allow SMS Messaging
By default, SMS messaging is disabled in Team Helpdesk. Check this option to enable SMS messaging for your helpdesk.
Default Country Code
Input the ISD code of your country. For example, for United States, it is 1 and for United Kingdom, it is 44. For more on
country code, click here.
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Use Skype to send SMS
Sending SMS via Skype is the simplest way of enabling support for SMS messaging functionality in Team Helpdesk. It is
cheap, convenient, seems relatively reliable too! Every technician needs to have Skype installed with valid credits to send
SMS to mobile phones. There are no specific settings that needs to be configured in Skype. The only requirement is that
it should be running with valid credits. Skype is seamlessly integrated with Team Helpdesk i.e., the sending of SMS via
Skype is done programmatically (through Skype API) which means the technician does not perform any manual steps
during the process. The technicians won't even notice the Skype is being used during the whole process of SMS
messaging. For more on Skype SMS, visit the Skype website at https://www.skype.com/en/features/sms/.
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For the first time, when a technician tries to
send an SMS (or call) to a mobile or phone
number, Skype would automatically pop up
a message asking you if to allow the
Outlook Application (Outlook.exe) access to
that Skype functionality.

You will have to select the first option 'Allow this program to use Skype' and then click OK to continue. This
setting is performed only one-time per user; subsequent access happens seamlessly to the technicians, i.e., Skype
remembers the selected option and would allow access as long as the user don't explicitly unset it under Skype >
Tools > Advanced > ‘Manage other programs access to Skype’.

Using an Email SMS Service
Choose this option if you have an Email to SMS gateway service that allows you to turn your email into a text message
without any extra effort. All that is needed is to send an email to mobile-number@SMS-SERVICE-DOMAIN.com
For instance, 933332323@someGateway.com where 933332323 is the mobile number to which the SMS will be sent to
and someGateway.com is the SMS gateways service.]
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With this SMS option enabled, Team Helpdesk add-in would then direct all SMS alerts (if enabled) in the form of emails
to mobile-number@[SMS-SERVICE-DOMAIN.com] after which the SMS gateway service take over to translate email to
SMS before delivering it to the mobile number.
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Special Code in Subject - If your SMS service provider requires a special code in the email subject for recognition or
authentication purpose, you can input it in the text box (outlined in red above). Doing so, the add-in will put this special
code in the subject of the email before sending it to the SMS provider account.
SMS Gateways - If your organization does not have an in-house Email to SMS service, there are plenty of commercial
Email to SMS service providers on the web. For example, SMS Gateways shown below are for U.S. carriers only.
SMS Gateways
Alltel Wireless

mobile-number@message.Alltel.com
mobile-number@text.wireless.alltel.com

AT&T Wireless

mobile-number@txt.att.net

AT&T Mobility (formerly Cingular)

mobile-number@cingularme.com
mobile-number@mobile.mycingular.com

Boost Mobile

mobile-number@myboostmobile.com

Cricket

mobile-number@sms.mycricket.com

Metro PCS

mobile-number@mymetropcs.com

Sprint (PCS)

mobile-number@messaging.sprintpcs.com

Sprint (Nextel)

mobile-number@page.nextel.com

U.S. Cellular

mobile-number@email.uscc.net

Verizon

mobile-number@vtext.com

Virgin Mobile

mobile-number@vmobl.com

Sending SMS to a caller/technician
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Once a SMS option is configured, technicians then can start sending self-composed SMS to caller or other technicians based on the
helpdesk requirements. For instance, from the case form, technician can click the ‘SMS’ button (mobile field of the caller) to send a
custom message to the caller.
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And to send a SMS message to one of the assigned technician, select the technician from the list, and click the ‘SMS’ button.
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Automating SMS reminders
Team Helpdesk can also send out automatic SMSs based on different helpdesk events such as when a case is created, changed or
resolved, or when a technician is assigned to the case, or when the due date has lapsed etc. This whole exercise is transparent to the
technicians and needs no manual intervention from the technicians. For more on automatic notifications, refer to Team Helpdesk
Manager > Notification Options > General Alerts tab.
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4.20 Predefined Answers (FAQs)
There might be times when technicians just need to answer briefly to a frequently asked question from callers. Instead of framing
the answer over and over again, just imagine how easy it would be if you can compose a predefined answer lists with relevant
answer categorized by problems. With such a setup, it is very easy to reply to a support request email by just selecting the
appropriate predefined answer and embedding it to the email.
You can maintain a list of predefined answers (FAQ) to most asked help desk questions. These answers can then be used to reply to
frequent asked questions quickly without needing to compose redundant information again and again. Each predefined answer can
be specified to belong to a problem category and type. This is particular helpful to build an organized library of answers that is easy
to find in time of need.

Frame a new question and answer.
Edit the selected question and answer.
Remove the selected question and answer from the list.
Problem Category for which this question and answer belongs to. You can choose a category from the drop-down list. To
add or modify categories, refer to Team Helpdesk Manager > Problems List > Categories tab.
Problem type for which this question and answer belongs to. You can choose a type from the drop-down list. To add or
modify types, refer to Team Helpdesk Manager > Problems List tab.
Frame your question here.
Click to edit the existing question. This will allow you to modify the existing question in an input box prompt.
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The detailed answer of the question that address an issue related to the problem category or type. A WYSIWYG editor is
available to help you format the content of your answer. You can change the font, style, paragraph etc.
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How are Predefined Answers Used?
The predefined answers list is most prominently used in the outlook case form. When launched, the predefined answers dialog box
displays questions which are arranged and grouped in a hierarchical tree (e.g. problem categories and types) allowing the technician
to select an answer and reply to the caller.
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And the chosen answer (FAQ) is inserted to a new reply, ready for dispatch to the recipient (e.g., caller of the case).
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The predefined answers can also be used to select an appropriate answer and reply directly to emails (outside of Team Helpdesk
folders) say in your Inboxes. In fact, they are available in appointments, tasks as well.
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4.21 Automatic Email Monitoring and Assignment
Many organizations believe e-mail is a highly efficient way to have their customers submit service and support requests. Your
customer types in the problem, presses send, and within seconds, it is in support mailbox of your helpdesk account. But the reality is
that nothing happens until someone reads it, creates a support case from it (this usually involves cutting and pasting from the email), and assigns it to an engineer or technician for resolution. Because there is both manual labor and personal attention involved,
the process can result in delays, support requests falling into the cracks, errors in transcription, and unhappy clients. And
unfortunately, this can become a barrier in the helpdesk main goal, which is to provide timely response to the caller. This is a
nightmare scenario for helpdesk team.
Fortunately, this is easily avoided in Team Helpdesk System. As it is integrated seamlessly with your Outlook email client, there is no
requirement to cut and paste information from the email to the support case. Even better, there is no need to manually process
each email. As a helpdesk manager, you can configure Team Helpdesk System to monitor any number of mailboxes and email folders
(such as public folders) such that it can intercept incoming emails and automatically generate support cases out of the emails, all
instantly i.e., as and when emails hit the inbox. With this kind of setup, the managers are freed from having to monitor inboxes
manually every now and then.
Additionally, Team Helpdesk can be extended to even assign default technicians to newly logged support cases on the fly based on
the linked relationship between technicians and the prefilled fields such as sender and problem areas. This automates the support
case logging and assignment entirely on its own. The generated support cases are then stored under the exchange folder making it
available to all members of your team for collaboration. Any file attachments will be automatically attached to the problem case
(Outlook item); making distribution of inbound requests simple and informative. This way, all support submissions are captured and
centralized in order to execute efficient and effective customer service.
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Choose a mailbox account or email folder (such as an Exchange folder or Public Folder) from which Team Helpdesk addin will raise new cases from incoming emails automatically.
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Once a mailbox account or email folder is chosen, click ‘Confirm and Add’ to the list for automation.

The folder or mailbox that has been chosen for automation.
Select a particular problem category from the drop-down list that will be set to the new case as default value for
‘Problem Category’ field.
Select a particular problem type from the drop-down list that will be set to the new case as default value for ‘Problem
Type’ field.
Choose technicians from the address book (or GAL) that will be assigned as default technicians to the new case raised
from this mailbox or email folder.
Select a suitable service level (SLA) from the drop-down list that will be set to the new case as default value for ‘Service
Level’ field.
Enable or disable the case automation workflow for the particular mailbox account or email folder. You may want to
disable the automation process temporarily on a particular mailbox or folder if for instance, a maintenance or migration
is planned.
This column shows which particular user (of Team Helpdesk Manager add-in) is responsible for automation.
The 'Action Mode' consists of 3 possible values: New, Update and Both.
A) If ‘New’ option is selected, Team Helpdesk will automatically raise new support cases from new incoming emails from
the particular monitored mailbox or folder. With this option, only those emails without the case ID in the subject would
be processed to generate new cases. Those with Case ID info in the subject will remain unprocessed.
B) If ‘Update‘ option is selected, Team Helpdesk will only process new incoming emails that have the case ID in the
subject and accordingly, it will update the associated case item (in the Ongoing Cases or Resolved Cases folders). Emails
without the Case ID information in the subject will remain untouched. This is handy if the mailbox or folder contains or
receives emails that are unrelated to the helpdesk.
C) If ‘Both’ option is selected, Team Helpdesk will update the existing cases as well as generated new tickets from new
incoming emails (depending on the availability of the Case ID in the subject of the email). This is the default selected
option when you add a new mailbox or folder for automation.
You can specify a different auto-response to caller for cases raised from each monitored mailbox. For instance, if
someone sends an e-mail to UK.Support@myCompany.com, you would want to inform the customer that their e-mail
will be responded to within 2 hours between 9am and 5:30pm UK time. If they send a new case to
US.Support@myCompany.com, you can inform the customer that their e-mail will be responded to within 3 hours
between 9am and 5:30pm Eastern Standard Time.
Enable this option to assign technicians that are associated to the problem type of the monitored folder to the newly
generated cases
Enable this option to enforce service level that are associated to the problem type of the monitored folder to the newly
generated cases
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Check this option to automatically convert incoming emails in 'Ongoing Cases' folder to support cases. For this feature to
work, the 'Ongoing Cases' folder needs to mail-enabled. You can also drag and drop emails from other folders to the
‘Ongoing Cases’ folder and the add-in will automatically process and convert those emails to cases.
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Workload – Assign responsibility for Case Automation

In Team Helpdesk, you need to specify which helpdesk manager add-in would be responsible for monitoring and converting the
emails from the admin chosen mailboxes/folders to cases. You can choose a particular technician or a dedicated system (that has the
manager installed) for this automation job.
Choose this option to assign a particular technician whose helpdesk manager add-in will be responsible for monitoring
and processing any incoming emails in the chosen mailboxes/folders to cases.
NOTE: If you want to set yourself, just click the ‘Self’ button (located on the right)
Choose this option to assign a dedicated system that has helpdesk manager add-in installed as responsible for monitoring
and processing any incoming emails in the chosen mailboxes/folders to cases. Enter the computer name without the
domain information. For example, if the full qualified system name is system1.domain.local only enter ‘system1’.
NOTE: If you want to set your current system, just click the ‘My Computer’ button (located on the right)
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Enable this option so that the manager add-in of the chosen user or system for ticket automation is also responsible for
monitoring due date lapse and SLA breach and consequently sending of the associated automated notifications to
technicians and supervisors.
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4.22 Web Access
For remote technicians who cannot access and work on support cases in the public folder or shared folder of the company's
exchange server or to allow general customers (end-users) to submit online support requests, Team Helpdesk provides them an easy
web interface accessible through a web browser on the internet. For this feature, the web access files are placed under a new virtual
directory in your IIS server with appropriate permission over the web folder. Technicians and to some extent, existing callers, will be
prompted to enter user credential when logging in to the web access website.

Customer Web Service
The Customer Web Service (or CWS which we will refer to often in this manual) is an AJAX enabled ASP.NET 2.0 website. It provides
a rich set of tools and interactivity with the live helpdesk ticket data stored in the exchange server. Your customers can submit new
support requests via a webform, check status of a support case and check out the knowledge base for possible workarounds to their
problem before requesting for support. Furthermore, existing callers can login to the Caller Web Access (CWA) * website to track all
their support cases, escalate or withdraw ongoing case, re-open closed case etc.

Here, you need to specify the shared network path of the CWS folder (which is located in your IIS C:\inetpub\wwwroot
parent folder on your windows server). To save/update the CWS specific XML metadata files from Outlook to the shared
network web-enabled folder (on the server), it needs to know the full UNC folder path. If the network folder resource
requires a network credential, then you will be prompted to enter one.
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NOTE: You need to share this CWS folder such that all technicians can have access to it from their respective systems
within the office network.
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Automatically update CWS metadata XML files (including web.config)
Enable this option to allow helpdesk add-in to update the CWS specific settings metadata automatically when there is
any change in the Team Helpdesk settings. The Team Helpdesk lists and settings (e.g. problem categories and types)
would surely change/update in due time. The helpdesk manager would need to update the web service XML metadata
files accordingly, so that data used in the web service application is in synch with that in Outlook. Though the helpdesk
manager can manually update the data files for web service, it would be a tedious task if the settings in Outlook are to
change every now and then. In such scenario, it is recommended to allow helpdesk add-in to automatically update CWS
specific metadata XML files in the shared network folder, when there are any changes in the lists and settings in Outlook.

Update Knowledge base data XML files
Check this option to publish or update knowledge base data XML files in the web-enabled CWS network folder.
Make the Time Spent accessible to Caller Web Access (CWA)
Enable this option so that when callers are logon to the Caller Web Access site, they can see the time spent details
entered by technicians in the cases allotted to them.
Make Email History accessible to Caller Web Access
Enable this option so that when callers are logon to the Caller Web Access site, they can see the Email communication
history between them and the helpdesk in the cases allotted to them.
Make private notes accessible to Caller Web Access
Enable this option so that when callers are logon to the Caller Web Access site, they can see private notes entered by
technicians in the cases allotted to them.
Web URL of CWS site
Enter the full web friendly URL (e.g. http://www.yourcompany.com/CWS/) that is accessible by your customers from the
Internet or Intranet. What you entered here will be available for embedding into email template (i.e., Placeholder
variable SCO_WEBACCESS_URL) which would be then sent to the customer after a case is raised from their support
request email or call.
Enter the confirmation information from the helpdesk to be displayed in the webpage of CWS when a new case is
submitted successfully by a customer through the webform.

*Caller Web Access (CWA) - is a part of the Customer Web Service (CWS) site, requires a user credential for caller to access their support cases online. Helpdesk
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managers can define this credential (e.g. password) in the Team Helpdesk Callers list dialog. Alternatively, a random password can be generated automatically
when a new caller is added to the Callers list.
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How does it work?
The Team Helpdesk web case submission allows for your end-users and customers to submit their service request through an
intuitive, easy-to-use web form interface; needing only their favorite web browser.
The Customer Web Service (CWS) is a collection of ASP.NET webpages that cater to the helpdesk end users on the web. It consists of
a structured support request submission webform, a support case status querying form, a self-service knowledge base and a special
web interface exclusively for existing callers to access their support cases online. All these sections are available to any users
accessing the customer service website except for the Caller Web Access (CWA) site, where only existing users are allowed to do so
from the web.
Unlike other traditional web-based helpdesks, CWS site in Team Helpdesk does not require a dedicated database. Instead, the
support cases submitted by customers are directly feed into the Team Helpdesk folders (i.e., stored in Exchange server) via one of
the helpdesk manager add-in installed in Outlook (which can be set under Team Helpdesk Manager > Web Access > Workload). The
helpdesk manager add-in services requests coming from CWS site and behaves like a server. That is why, we recommend that you
assign the workload of processing and servicing the TWA and CWS sites to a dedicated system that is running 24x7.

Allows end-user to enter information on their problem on a structured web form.
Allows end-user to check and track the status of their support cases online.
Allows end-user to browse or search through the web-based knowledge base articles to find a solution on their problem.
Allows existing callers to access their exclusive member area online such that they can view support cases history,
submit new support request directly, escalate or cancel ongoing cases or reopen existing resolved cases.
Why is Online Customer Service Important?
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Web-enabled customer service provides a variety of benefits. In addition to the fact that many prospective customers will refuse
to do business with an organization if they don't offer some level of online support, benefits include:
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o
o
o
o
o
o
o
o

24/7 customer service capability
immediate response to customer inquiries
meeting/exceeding constantly evolving customer demands
improved customer satisfaction and customer relationships
cost savings
automation of repetitive tasks makes it easy for customers to do business with you
re-allocation of customer service staff to value-add tasks
acquisition of invaluable customer feedback and requests

Configure Customer Web Service (CWS) on IIS
Before end-users and callers can start using Customer Web Service (CWS), the helpdesk administrator needs to first setup and
configure certain settings, in the web access administrative panel in Team Helpdesk Outlook, and then on the IIS web server.
To install, setup and use Customer Web Service (CWS), the followings list the requirements on both the web server and the
customer’s system.

On the Web Server system
• Microsoft Internet Information Server
• Microsoft ASP.NET 2.0 Enabled
• Write permission for ASP.NET users on a temporary subfolder under CWS IIS folder
Note: As there is no direct interfacing between the CWS site and your Exchange server, the IIS web server does
not need to be on the same windows server as that of your Exchange server, but should be under the same
office network.
On the Customer’s system
• Any Web browser
• Internet Connection

The followings list all the steps required to be performed to get CWS website running in few minutes.
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Step 1: Setting up an Application under IIS
Step 2: Set appropriate network permission to the IIS shared folder
Step 3: Extract/Copy all Customer Web Access application files to the IIS web folder
Step 4: Set ASP.NET permission on Temp sub-folder
Step 5: Configure web Access specific settings in Team Helpdesk add-in
Step 6: Write/Update XML metadata files from Team Helpdesk for Outlook
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Step 1: Setting up an Application under IIS
The first step in setting up the Customer Web Service (CWS) site requires creating a new application under your IIS server. In this
document, we discuss the configuration of an application on your default web site under your IIS.
To create a new application, right-click the site and select ‘Add Application…’.

You will be prompted with the ‘Add Application’ dialog box.

Page

120

First, set the CWS application to use .NET CLR 2.0 application pool by clicking ‘Select…’ button in the ‘Application Pool’.
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Type the alias for the Application, say, CWS and specify the physical folder on the local server to map to this alias. In this case, the
physical folder on the server is C:\Inetpub\wwwwroot\CWS
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Click OK. The image below displays the result.
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Step 2: Set appropriate network permission to the shared folder
The just created 'CWS' IIS Application now needs to be set as a shared network folder for all the helpdesk technicians that uses Team
Helpdesk for Outlook. Data interchange between the customer web access and the Team Helpdesk add-in in Outlook uses XML
formats and are written to a temporary subfolder 'Temp' under the application folder. Due to this requirement, all helpdesk
technicians working in Outlook will need to have full control over the 'CWS' network folder.
Right-click the CWS application from the tree view and click ‘Edit Permissions…’

We need to grant full control to this folder (e.g. C:\Inetpub\wwwroot\CWS) in both Sharing and Security tabs. Let us start with the
first one. Click the Sharing tab > Advanced Sharing…
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From the ‘Advanced Sharing’ box, enable the option
‘Share this folder’.
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And then click ‘Permissions’.

Once you are in the permissions dialog, you will see that
by default, any users on the local network have read
permission over the shared folder. For our needs, we
need to allow all helpdesk users to save/update files
under this folder. So, either you can add individual user
or a group (if you have it defined).

In our example, we have defined a group 'ServiceDesk'
comprising of all helpdesk users so that setting
permission for all users can be done in a single click.
Check the option 'Full Control' to allow all technicians in
the helpdesk team to save/update 'Customer Web
Service' specific metadata XML files.
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Likewise, add the same helpdesk group (e.g. ServiceDesk)
under the Security tab and grant 'Full Control' access.
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Step 3: Extract all Customer Web Service (CWS) application files
Now that we have created an exclusive web-enabled physical folder on the server and granted full control to all helpdesk users (step
1 and 2 respectively), the next step is to extract all the files and subfolders from the Customer Web Service zip archive (e.g. CWS.zip)
to the shared network IIS folder.
This CWS.zip is installed with Team Helpdesk Manager, and is located under the following folder in your system:
C:\Users\USERNAME\AppData\Roaming\AssistMyTeam\Team Helpdesk Resources
The contents of 'CWS.zip' are shown below:
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Extract all the files and subfolders under the zip (e.g. CustomerWebService.zip) file to the network shared web-enabled Customer
Web Service (CWS) folder. For example, \\192.168.1.4\CWS where '192.168.1.4' is the windows server and 'CWS' being the webenabled folder (either configured as a website or virtual directory under an existing website in IIS). If step 2, if the permission (e.g.
full control) was successfully set, the files and subfolder would be extracted/copied to the network share.
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Step 4: Set ASP.NET (Internet Guest Account) permission on Temp folder.
The Customer Web Service functionality is built upon ASP.NET 2.0 and AJAX technology. Typically, an ASP.NET application requires
read, execute, and list access for the ASP.NET account (also known as Internet Guest Account) for the web site root (for example:
D:\inetpub\wwwroot\CWS or any alternative site directory you may have configured in IIS), the content directory and the
application root directory in order to monitor for configuration file changes. The application root corresponds to the folder path
associated with the application virtual directory in the IIS Administration tool.
Under your IIS server, you have multiple subfolders under the CWS application. The special interest that we have now is for the
'Temp' folder, as this is the folder that saves uploaded attachments from support request case temporarily. Hence, the ASP.NET
account needs to be configured to have ‘Full Control’ over this 'Temp' folder. You do that by right-clicking 'Temp' folder > ‘Edit
Permission…’.

From the Temp properties dialog box, click the ‘Security’ tab, and click
the ‘Edit…’ button to invoke the ‘Permissions’ tab.
In the ‘Permissions’ dialog box, select the ASP.NET (Internet Guest)
account. Different version of IIS has different ASP.NET account name.
For example, in IIS version 5 (windows 2000 server), it is ASPNET, and
in IIS version 6 (windows server 2003), it is IIS_WPG group whereas in
IIS 7 and above version (Windows 7 and above), it is IIS_IUSRS group.
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In the screenshot below, we have IIS 7 version and hence, the IIS_IUSR
group is allowed 'Full Control' over the 'Temp' folder.
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Step 5: Configure CWS specific settings from Outlook
The Customer Web Service (CWS) site does not make use of a database to store the helpdesk settings and lists. Instead, the data and
settings are stored as XML metadata files and are saved/updated from the Team Helpdesk add-in interface in Outlook (by helpdesk
managers/technicians). The document takes you to finer detail on various web access settings that need to be configured in the
administrative tool, before saving/updating the XML metadata files in the IIS folder.
Displayed below is a part of the Customer Web Service (CWS) settings dialog. To save/update the CWS specific XML metadata files
from Outlook to the shared network web-enabled folder (on the server), it needs to know the full UNC folder path. If the network
folder resource requires a network credential, then you will be prompted to enter one
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The Caller Web Access (CWA) site, which is a part of the Customer Web Service (CWS) site, requires a user credential for caller to
access their support cases online. Helpdesk managers can define this credential (e.g. password) in the Team Helpdesk Callers list
dialog. Alternatively, a random password can be generated automatically when a new caller is added to the Callers list.
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Step 6: Write/Update XML metadata files from Outlook
The last remaining step is to save/update the Customer Web Service (CWS) specific XML metadata files in the CWS network webfolder. The XML metadata files contain the required Team Helpdesk lists and settings defined by the helpdesk manager in Outlook
and these files feed data to the Customer Web Service applications when end-users submit new support requests via web-form or
when caller login to load their support cases.
Before any XML data files can be updated, the helpdesk manager needs to specify the network share that was configured in Step 2. If
the appropriate permission was set, clicking the 'Update data' button generate all the required XML files.
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Now, open your web browser and point to the CWS URL. Usually the URL is in the format http://SERVER/CWS/. For example, in our
instance, it would be http://byteStation/CWS/
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Technicians Web Access (TWA)
The Technician Web Access (or TWA which we will refer to often) is an AJAX enabled ASP.NET 2.0 website. It provides a rich set of
tools and interactivity with the live helpdesk data stored in the exchange folder. Technicians can create new case, work on existing
case and close, re-open or delete case directly from within the web access form.

Here, you need to specify the shared network path of the TWA folder (which is located in your IIS C:\inetpub\wwwroot
parent folder on your windows server). To save/update the TWA specific XML metadata files from Outlook to the shared
network web-enabled folder (on the server), it needs to know the full UNC folder path. If the network folder resource
requires a network credential, then you will be prompted to enter one.
NOTE: You need to share this TWA folder such that all technicians can have access to it from their respective systems
within the office network.
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Automatically update TWA metadata XML files (including web.config)
Enable this option to allow helpdesk add-in to update the TWA specific settings metadata automatically when there is
any change in the Team Helpdesk settings. The Team Helpdesk lists and settings (e.g. problem categories and types)
would surely change/update in due time. The helpdesk manager would need to update the web service XML metadata
files accordingly, so that data used in the web service application is in synch with that in Outlook. Though the helpdesk
manager can manually update the data files for web service, it would be a tedious task if the settings in Outlook are to
change every now and then. In such scenario, it is recommended to allow helpdesk add-in to automatically update TWA
specific metadata XML files in the shared network folder, when there are any changes in the lists and settings in Outlook.
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How It works?
The Technician Web Access (TWA) site is an AJAX enabled ASP.NET 2.0 application and provides a rich set of tools and interactivity
with the live data in the exchange folder. Unlike other traditional web-based helpdesks, TWA site in Team Helpdesk does not require
a dedicated database. Instead, the support cases data are sourced from your Exchange server via one of the helpdesk manager addin installed in Outlook (which can be set under Team Helpdesk Manager > Web Access > Workload). The helpdesk manager add-in
services requests coming from TWA site and behaves like a server. That is why, we recommend that you assign the workload of
processing and servicing the TWA and CWS sites to a dedicated system that is running 24x7.
The idea behind the TWA is not to substitute the Team Helpdesk add-in functionality, rather it is to complement the support of a
web interface from where remote technicians that do not have access to the MS Exchange resource, can easily work on support
cases, thereby not handicapping the helpdesk operation, when some technicians are offsite.

Technicians with valid web access rights will be prompted to enter user credential when logging in to the TWA website. The
password required here is defined by the helpdesk managers for each technician in the Team Helpdesk technician list. Apart from
the password, helpdesk managers also can also specify if a particular technician can login to the TWA, by toggling the 'admin access'
switch for each technician.

Once logged in, the technician will be taken to the
'Member' section where he/she can decide what to
perform in the TWA web interface.
That is, either, each technician can choose to access
only their cases, or load other cases based on criteria
such as case ID, technician name, caller etc.
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Technician can also choose to create a new support
request case that will be submitted to Team Helpdesk
add-in on Outlook for further processing and storing
the support case in the exchange folders.
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Configure Technician Web Access (TWA) site in IIS
Before remote technicians can start using Technician Web Access (TWA), the helpdesk administrator needs to first setup and
configure certain settings, in the web access administrative panel in Team Helpdesk Outlook, and then on the IIS web server.
To install, setup and use Technician Web Access (TWA), the followings list the requirements on both the web server and the client
system.
On the Web Server system
• Microsoft Internet Information Server
• Microsoft ASP.NET 2.0 Enabled
• Write permission for ASP.NET users on a temporary subfolder under TWA IIS folder
Note: As there is no direct interfacing between the TWA site and your Exchange server, the IIS web server does
not need to be on the same windows server as that of your Exchange server, but should be under the same
office network.
On the Customer’s system
• Any Web browser
• Internet Connection

The followings list all the steps required to be performed to get TWA website running in few minutes.
Step 1: Setting up an Application under IIS
Step 2: Set appropriate network permission to the IIS shared folder
Step 3: Extract/Copy all files of Technician Web Access to the IIS web folder
Step 4: Set ASP.NET permission on Temp sub-folder
Step 5: Configure web Access specific settings in Team Helpdesk add-in
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Step 6: Write/Update XML metadata files from Team Helpdesk for Outlook
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Step 1: Setting up an Application under IIS
The first step in setting up the Technician Web Access (TWA) site requires creating a new application under your IIS server. In this
document, we discuss the configuration of an application on your default web site under your IIS.
To create a new application, right-click the site and select ‘Add Application…’.

You will be prompted with the ‘Add Application’ dialog box.
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First, set the TWA application to use .NET CLR 2.0 application pool by clicking ‘Select…’ button in the ‘Application Pool’.
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Type the alias for the Application, say, TWA and specify the physical folder on the local server to map to this alias. In this case, the
physical folder on the server is C:\Inetpub\wwwwroot\TWA.
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Click OK. The image below displays the result.
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Step 2: Set appropriate network permission to the shared folder
The just created 'TWA' IIS Application now needs to be set as a shared network folder for all the helpdesk technicians that uses Team
Helpdesk for Outlook. Data interchange between the Technician web access (TWA) and the Team Helpdesk add-in in Outlook uses
XML formats and are written to a temporary subfolder 'Temp' under the application folder. Due to this requirement, all helpdesk
technicians working in Outlook will need to have full control over the 'TWA' network folder.
Right-click the TWA application from the tree view and click ‘Edit Permissions…’

We need to grant full control to this folder (e.g. C:\Inetpub\wwwroot\TWA) in both Sharing and Security tabs. Let us start with the
first one. Click the Sharing tab > Advanced Sharing…
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From the ‘Advanced Sharing’ box, enable the option ‘Share this folder’. And then click ‘Permissions’.

Back to TOC

Once you are in the permissions dialog, you will see that by default, any users on the local network have read permission over the
shared folder. For our needs, we need to allow all helpdesk users to save/update files under this folder. So, either you can add
individual user or a group (if you have it defined).

In our example, we have defined a group 'ServiceDesk' comprising of all helpdesk users so that setting permission for all users can be
done in a single click. Check the option 'Full Control' to allow all technicians in the helpdesk team to save/update ‘Technician Web
Access’ specific metadata XML files.
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Likewise, add the same helpdesk group (e.g. ServiceDesk) under
the Security tab and grant 'Full Control' access.
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Step 3: Extract all Technician Web Access (TWA) application files
Now that we have created an exclusive web-enabled physical folder on the server and granted full control to all helpdesk users (step
1 and 2 respectively), the next step is to extract all the files and subfolders from the Technician Web Access zip archive (e.g. TWA.zip)
to the shared network IIS folder.
This TWA.zip is installed with Team Helpdesk Manager, and is located under the following folder in your system:
C:\Users\USERNAME\AppData\Roaming\AssistMyTeam\Team Helpdesk SP Resources
The contents of 'TWA.zip' are shown below:
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Extract all the files and subfolders under the zip (e.g. TechnicianWebAccess.zip) file to the network shared web-enabled Technician
Web Access (TWA) folder. For example, \\192.168.1.4\TWA where '192.168.1.4' is the windows server and 'TWA' being the webenabled folder (either configured as a website or virtual directory under an existing website in IIS). If step 2, if the permission (e.g.
full control) was successfully set, the files and subfolder would be extracted/copied to the network share.
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Step 4: Set ASP.NET (Internet Guest Account) permission on Temp folder
The Technician Web Access functionality is built upon ASP.NET 2.0 and AJAX technology. Typically, an ASP.NET application requires
read, execute, and list access for the ASP.NET account (also known as Internet Guest Account) for the web site root (for example:
D:\inetpub\wwwroot\TWA or any alternative site directory you may have configured in IIS), the content directory and the
application root directory in order to monitor for configuration file changes. The application root corresponds to the folder path
associated with the application virtual directory in the IIS Administration tool.
Under your IIS server, you have multiple subfolders under the TWA application. The special interest that we have now is for the
'Temp' folder, as this is the folder that saves uploaded attachments from support request case temporarily. Hence, the ASP.NET
account needs to be configured to have full control over this 'Temp' folder. You do that by right-clicking 'Temp' folder > ‘Edit
Permission…’.

From the Temp properties dialog box, click the ‘Security’ tab,
and click the ‘Edit…’ button to invoke the ‘Permissions’ tab.
In the ‘Permissions’ dialog box, select the ASP.NET (Internet
Guest) account. Different version of IIS has different ASP.NET
account name. For example, in IIS version 5 (windows 2000
server), it is ASPNET, and in IIS version 6 (windows server 2003),
it is IIS_WPG group whereas in IIS 7 or above version, it is
IIS_IUSRS group.
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In the screenshot below, we have IIS 7 version and hence, the
IIS_IURS group is allowed 'Full Control' over the 'Temp' folder.
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Step 5: Configure TWA specific settings from Outlook
The Technician Web Access (TWA) site does not make use of a database to store the helpdesk settings and lists. Instead, the data
and settings are stored as XML metadata files and are saved/updated from the Team Helpdesk add-in interface in Outlook (by
helpdesk managers/technicians). The document takes you to finer detail on various web access settings that need to be configured
in the administrative tool, before saving/updating the XML metadata files in the IIS folder.
Define password for each technician for web access: Open up the Team Helpdesk Manager menu > 'Technicians list' panel and for
each technician, define a password to enable individual technician to login to Technician Web Access on the web using the
technician's email ID and password.
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There is an exclusive web access setting dialog, which is displayed above. To save/update the XML metadata files from Outlook to
the shared network web-enabled folder (on the server), it needs to know the full UNC folder path. If the network folder resource
requires a network credential, then you will be prompted to enter.
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Step 6: Write/Update XML metadata files from Outlook
The last remaining step is to save/update the Technician Web Access (TWA) specific XML metadata files in the TWA network webfolder. The XML metadata files contain the required Team Helpdesk lists and settings defined by the helpdesk manager in Outlook
and these files feed data to the Technician Web Access applications when end-users submit new support requests via web-form or
when technician login to load their assigned cases.
Before any XML data files can be updated, the helpdesk manager needs to specify the network share that was configured in Step 2. If
the appropriate permission was set, clicking the 'Update data' button generate all the required XML files.

Automatically update TWA metadata XML files (including web.config): In due course, the Team Helpdesk lists and settings would
change/update (e.g. problem categories and types). This requires the helpdesk manager to manually update the web access XML
metadata files accordingly (by clicking the 'Update data'), so that data used in the web access application is in synch with that in
Outlook. Though the helpdesk manager can manually update the data files for web access, it would be a tedious task if the settings
in Outlook are to change every now and then. In such scenario, it is recommended to allow Team Helpdesk (in Outlook) to
automatically update web access specific metadata XML files in the shared network folder, when there are any changes in the lists
and settings in Outlook.
Now, open your web browser and point to the TWA URL. Usually the URL is in the format http://SERVER/TWA/
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For example, in our instance, it would be http://byteStation/TWA/
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Workload – Assign responsibility for Web Access Servicing
In Team Helpdesk, you need to specify which helpdesk manager add-in would be responsible for monitoring and servicing all the
web requests coming from the Customer Web Service (CWS) and Technicians Web Access (TWA) websites. You can choose a
particular technician or a dedicated system (that has the manager installed) for this automation job.

Choose this option to assign a particular technician whose helpdesk manager add-in will be responsible for servicing all
web requests from CWS and TWA websites (if configured).
NOTE: If you want to set yourself, just click the ‘Self’ button (located on the right)
Choose this option to assign a dedicated system that has helpdesk manager add-in installed as responsible for servicing
all web requests coming from CWS and TWA websites. Enter the computer name without the domain information. For
example, if the full qualified system name is system1.domain.local only enter ‘system1’.
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NOTE: If you want to set your current system, just click the ‘My Computer’ button (located on the right)
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5. Search Cases
So, you have a repository of support request cases stored in your exchange folders. As the number of logged cases multiplies,
finding the right information at the time of need is crucial for helpdesk team. For example, more so then often, technicians
would require querying information based on particular cases, assets, callers etc. Team Helpdesk supports a comprehensive
search capability with rich filter sets including full text search on case description body, or on predefined drop-down lists such
as caller, technician, department etc.
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Time Period: Choose a time period from the followings under which the search will be confined:
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Any
Today
Yesterday
Tomorrow
This week
Last Week
Next Week
This Month
Last Month
Next Month
This Year
Last Year
Date Range...
On

Report Type: Choose a report type from the predefined ones below:
Any
Cases Created
Cases Resolved
Cases Ongoing
Cases Worked
Cases Due
Cases Response Date
Cases unassigned
Cases lapsed - Due Time
Cases lapsed - Response Time
Cases with SLA Breach - Due Date
Cases with SLA Breach - Response Date
Cases with no Due Date
Cases with no Response Date
Cases with no Service Level
Cases with no Caller

Search By: Further refine the search by filtering through keywords or using one of the following helpdesk fields Technicians, Status, Problem, Service level, Caller, Department, Company, Priority, Origin, Assets or Author.
Group By: You can choose to group the cases either with - Technicians, Status, Problem Category, Problem Type, Service
level, Caller, Department, Company, Priority, Origin, Assets or Author.
Fields: You are free to choose which particular
helpdesk fields/columns show up in the search
result and report. Just click the 'Fields' button,
and choose the wanted columns to include.
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The tool will remember your choice in
subsequent runs. You can re-arrange the
columns by drag-and-drop to get the kind of
view you want. And the display order of the
columns will be retained in subsequent
sessions.
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Scope: Choose if to confine the search to your assigned cases only or include all cases.

Reply: Compose and send a reply email to the caller of the selected case.
Reply with a KB: Choose a KB article and embed it to a reply email to the caller.
Edit: Open the selected case in its inspector window in Outlook for viewing or further editing.
Mark Complete / Re-Open: If the selected case is ongoing, you can click this button to mark it complete. And if it a
resolved case, you can click to re-open it,
Delete: Permanently remove the selected cases from the Team Helpdesk folders
Export to PDF: Click this to export the selected cases to PDF document files. You can also export to Word Documents,
HTML, plain text etc.

Multiple cases can be batch exported. Just select multiple cases from the list and choose one of the document type to
export to, and the batch wizard will perform the rest.
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You can control what case data are included in the files by customizing the 'Print' template under Team Helpdesk
Manager > Templates Manager. For example, place the variable 'SCO_CASEDESCRIPTION' in the Print template such that
the exported file (e.g. pdf) contains all the consolidated conversations (body) from the case item including inline images.
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Print: Click this to print the selected cases using the 'Print' template (as defined under Team Helpdesk Manager >
Templates Manager). If you select a single case to print, it will show you the print dialog option, where you can
customize the layout, paper size etc. However, if you choose multiple cases, it will print directly using the default
settings without displaying any ‘Print’ options.

6. Helpdesk Summary Reports
Helpdesk summary reports play a vital role in keeping informed managers about recent cases - that were created, worked,
overdue or resolved. Team Helpdesk provides an inbuilt tool that generates reports on support cases based on a specified
interval such as today, this week, this month, last month etc. Any fields can be selected for inclusion into the reports and can
be saved as to file or printed for sharing and easy distribution.
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There are four report view modes - List, HTML, HTML Editable and Grid. Noticed that this report tool also uses the same sets
of search filters discussed in the last section.
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Each case in the search result is color coded to reflect the current status of the case. You can easily recognize which cases
require the attention or review, and plan actions accordingly.

Time Period: Choose a time period from the followings under which the search will be confined:
Any, Today, Yesterday, Tomorrow, This week, Last Week, Next Week, This Month, Last Month, Next Month, This
Year, Last Year, Date Range, On
The option 'Date Range…' allows for user selection of start and end date.

Report Type: Choose a report type from the predefined ones below:
Any, Cases Created, Cases Resolved, Cases Ongoing, Cases Worked, Cases Due, Cases Response Date, Cases
unassigned, Cases lapsed - Due Time, Cases lapsed - Response Time, Cases with SLA Breach - Due Date, Cases with
SLA Breach - Response Date, Cases with no Due Date, Cases with no Response Date, Cases with no Service Level,
Cases with no Caller
Search By: Further refine the search by filtering through keywords or using one of the following helpdesk fields:
Status, Problem, Service level, Caller, Department, Company, Priority, Origin, Assets or Author.
Group By: You can choose to group the cases either with: Technicians, Status, Problem Category, Problem Type,
Service level, Caller, Department, Company, Priority, Origin, Assets or Author.
Fields: For finer control over the output of
report, you can choose which fields (including
custom fields and calculated fields) are to be
included in the report.
You can sort the items by clicking at the column
headers, as well as also re-arrange the columns
in the list view according to certain sequence of
your choice, and even set the width of the
columns. These formatting from the List view
panel will be inherited on other tabs - HTML,
editable HTML and Grids.
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The tool will remember your choice in
subsequent runs. You can re-arrange the
columns by drag-and-drop to get the kind of
view you want. And the display order of the
columns will be retained in subsequent
sessions.
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Some useful calculated fields that you can include in the report:

•
•
•
•
•

Raise Duration - interval between when the support request (email or phone call) was received and when
the case was raised.
Response Duration - interval between when the support request was received (email or phone call) and
when the first response was made to the caller (by a technician)
Open Duration - interval between when the case was raised and the current time.
Resolution Duration - interval between when the case was raised and when it was closed/completed.
Breach Duration - interval between when the case was due and when it was actually closed/completed.

Scope: Choose if to confine the search to your assigned cases only or include all cases.
Print the current report - When you click ‘Print’, you would be presented with the print dialog (similar to one used
by Internet Explorer browser). Within that dialog, you would be able to customize the print settings. Note that, as
there are multiple report modes (namely, list, HTML, Grid), the printed report will be sourced from the current
mode (tab) that you are in.
Save the current report to file – Once you get the look and feel of your report, you can then export the report to
one of the many popular document formats supported such as Microsoft Excel sheets, Word documents, Adobe
PDF, Rich Text or web page etc.
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List report view mode – This acts like a template to the other three report modes. For finer control over the
output of report, you can choose which fields (including custom fields) are to be included in the report. You can
sort the cases by clicking at the column headers, as well as also re-arrange the columns in the list view according
to certain sequence of your choice, and even set the width of the columns. These formatting from the List view
panel will be inherited on other tabs - HTML, editable HTML and Grids.
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HTML report view mode – This report view presents the cases in web HTML format with color coding, group, and
summary information retained. You can export this report to .htm format for your further use.
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HTML Editable report view mode – This report view is exactly the same as the previous HTML mode, but with the
flexibility to edit the HTML content in a WYSIWYG editor. For instance, you can customize the font, add image,
change the color, layout or add any further information you require so that you can compile your own report.
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The Grid report view mode – This presents the cases in excel spreadsheet like format with rows and columns,
preserving color codes, summarized information etc. You can also re-edit and tweak the report. You can also copy
data from this grid to Microsoft Excel or vice versa. And you can of course export the report as Excel spreadsheet
file (in XLXS, XLS format).
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7. Helpdesk OLAP Statistics and Reporting
With the integrated Online Line Analytical Processing (OLAP) tool, helpdesk managers can analyze the support request data in
multidimensional view and extract mission critical information and intelligence that will enable better decision- in your
helpdesk and organization. The tool supports the ability to explore large complex data sets and allows displaying in grids,
charts and graphs and support most common operations such as pivoting, drill down/slice and dice, filtering etc. With such
arrays of information, the organization can reengineer their help desk processes, reinforce resources and forecast problem
areas and exploit all these factors for competitive advantage.
Why OLAP? Real strength of OLAP is its ability to examine and view data in ways not ordinarily possible. By allowing varying
levels of granularity during data inspection and visualization a lot of information can be revealed that would otherwise be
hard to attain. Given that most business models are constrained by more than three dimensions, it is hard to fully evaluate a
business without the ability to inspect each dimension in detail while preserving context eliminating all guesswork. OLAP is
perfectly suited for this purpose. Now it’s easier than ever to spot new trends and discover unknown problems in your data
flow. The statistical tool will help you gain an insight into your data and make new discoveries. Comes with various inbuilt
reports specific to Team Helpdesk Cases.
Reporting made easier - The statistical tool's simplistic point-and-click interface will ensure managers easily achieve the highlevel views of information they require. Additionally, the OLAP client makes creating reports destined for different
management levels a simple task - eliminating managers' dependence on IT personnel. By unifying data analysis needs on a
single platform, it provides an unparalleled array of reporting tools for web portals, intranet applications, websites, and other
data-rich applications.
Printing capabilities - you can print your report to share it with others using the built-in Print Preview window. You can tune
your page/printer settings before printing. Also, if you feel like sharing the report through the net or by email you can easy
export it to a wide range of formats including PDF, XLS, CSV, JPG, etc.
Copy to Clipboard - Select any data range in Chart/Grid and copy to clipboard. Then you’ll be able to paste it in an Office
program for further analysis. You can also paste the chart like a picture to illustrate your investigations. This greatly simplifies
the task of creating detailed, data-rich documents.
Save Reports in file - At any stage managers/technicians can save the report and distribute it to another person for analysis by
network or email, so when the recipient gets the file he can open it and see the same OLAP slice.
Launching the statistics tool:
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Go to Outlook > File > Team Helpdesk
Manager tab, and click ‘Statistics’
button.
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You can choose what type of OLAP statistics on helpdesk data you would like to see and report on. You can specify if the
statistics would be confined to ongoing cases or resolved cases or on both. You can further have the choice to include
archived old cases that were moved to another exchange folder or PST file.

There are two parts of OLAP Statistics
General OLAP
Choose this OLAP to run statistics on cases with all helpdesk parameters and fields except for time spent by
technicians on cases.
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Time Spent OLAP
Choose this OLAP to run statistics on time spent entries by technicians on cases.
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7.1 The User Interface
The statistical tool presents an easy-to-use interface for operating an OLAP-slice. The basic data is displayed in the Working
area. The environment tools for managing the content and characteristics of the slice are placed on the pivot panels. You can
set the panels' layout the way you like. To drag a panel to a different location, you need to capture and drag its header with
the mouse. At that, all the possible locations, where it can be dropped to, will be highlighted. You can detach a panel from the
component; it will be displayed as a float window.

Instrumental panels can be:
• Attached to any side of the component;
• Placed into any existing panel;
• Displayed as bookmarks on any panel;
• Set as auto-hidden panels;
• Used as float windows.
You can change the view of the slice by relocating measures and hierarchies within the environment panel. When you start
dragging an element, all the possible locations, where it can be dropped to, will be highlighted. Most elements have context
menus that duplicate the mouse actions and provide additional control functions for managing the slices' view.
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The File menu
The file menu consists of the following commands:
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a)

Open Offline Cube from file - While generating a live cube from Outlook always provides the advantage of
analyzing live data, often, you might be away or disconnected from the network.
In such scenario, you have the option of connecting to an offline cube, which was previously generated and
saved to your local folder using this utility. An offline cube file has the extension - .offlinecube and can be
either in compressed or uncompressed format. An offline cube gives the same functionality as that of a live
cube (which is generated from the Outlook data at real time), except that the data in the offline cube is only
current to the time the cube was saved to file. This provides the flexibility to continue analyzing the cube
and writing reports etc, while you are on the move.
Open a Predefined View - Pre-defined reports are available under Assets, Cases, Callers, Date/Time,
Problems, and Technicians nodes. Clicking one of child node report loads the statistical analysis of that
report, the resultant of which will be displayed in the Grid or Chart (depending on the current active view).

c)

Load report file from Favorite – You can customize or create your own views and save them to the favorite.
Once saved, your views would be saved under the ‘C:\Users\USERNAME\Documents\Team Helpdesk
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b)
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Reports\Views’ folder (in windows Vista and 7). For windows XP, it should under My Documents. When you
open the favorite from this menu, you can choose to load your saved view.
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d)

Open report view from file - Once a particular snapshot of the statistics is achieved, you may want to save it
for future reference or share it among your team members. A report view is the current state of the
statistics in the Grid/Chart working area, with specific member fields on the pivot panels (Rows and Column
areas) and measure fields in the values area. It has a file extension ‘.olapreport’.

e)

Save report view to favorite – You can save the current view of the statistics (grid or chart) to the favorite,
by specifying a name of the view.

f)

Save report view as - If you want to share a report view with others, you can simply save the current report
(state of the statistics along with the pivot details) to a file folder of your choice - could be a network folder
also.

g)

Save to offline Cube – Once you have loaded a live cube from the cases, you have the option to save the
entire cube data to a file (with the extension - .offlinecube) for offline use, when you are disconnected from
the network. Offline cube can be saved in compressed or uncompressed format, the former option will
enable you to reduce the file size considerably.

h)

Same as e. (above)

i)

Close the cube - This option closes the cube from the OLAP Statistics and free up the memory for loading
another cube.

View Menu
Contains actions that you can perform on the current report view.

a) Reset Chart/Grid - Empty all the member fields from the pivot as well as the data from the working area of the
chart/grid. This is useful if you want to start over on a new report view.
b) Synchronize Chart/Grid - This option allows you to reflect the state of the statistics between the Grid and the
chart. It is particularly useful, for example, when you have built up a grid with aggregated data, but want a more
visual representation of the statistics in form of graphs and bars. Also note that, the synchronization will be
done to the other part (grid or chart) based on the current interface.
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For example, if you are in the grid view, and if you pressed ‘Synchronize Chart/Grid’ it would read the state of the
Grid view and impart the same state (same members and measures) to the Chart view and vice versa. Each of
the Grid and Chart view can be worked independently as long as you don’t press this synchronize option.
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OLAP Grid panel
The OLAP Grid control comprises of a multi-dimensional table with expandable nodes. These nodes group and
display data according to the hierarchies used to define the measures and dimensions upon which the underlying
data has been organized. A unique feature of control allows for building the OLAP-reports of the exceptional level
of complexity. In tandem with the OLAP Chart, the OLAP Grid provides an ideal means of clearly conveying data
to the user.
OLAP Chart panel

While OLAP Grid allows working with numbers, the OLAP Chart allows representing the project data graphically.
This gives managers and members a unique opportunity to analyze their project data visually, dealing with charts
rather than numbers, which is much easier to perceive.

Cube structure panel
The panel contains the Cube structure - measures and hierarchies as a tree. The measures are grouped in the set,
displayed in a branch. Rest of the tree nodes are the dimensions that contain hierarchies.
- Measure
- Dimension
- Attribute hierarchy
- Multilevel hierarchy

To select a measure for display you need to drag-n-drop it to
the Measures panel or the data area.
To select a hierarchy for display – drag-n-drop it to the
hierarchy area or the pivot panel (rows or columns area).
•
•

Measures are grouped in the Measures category.
Hierarchies are sorted into folders - dimensions. If there's
only one dimension in a hierarchy, it will be displayed in the
tree root.

Both hierarchies and measures have their own menus. Right click will call the context menu that gives you an
option to place the element where you like. You can also filter the selected element (see Filtering hierarchies and
measures) or place it to the selected panel.
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Pivoting panels
A pivot table lets user design the report online by dragging and dropping measures, dimensions and levels into
the pivoting panels. Note that the column panel may contain no more than one (!) measure. Panel elements can
be dragged with the mouse to other panels. To filter elements, press the Filter button (see Pivot panel view) or
use the appropriate items from the context menu.

Back to TOC

Measure panel
Measure panel consists of groups of measures that make up the charts' vertical axes (see Measure panel
components). Each group of measures corresponds to a set of charts in the data area. Groups of measures are
situated in the main part of the panel.

You can drag measures from one group to another, or extract measures from groups to delete them. To create a
new group, you need to drag a measure to a place on the panel not occupied by another group or to the <drop an
item to create a new group> panel.
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Clicking a mouse button on measures will call the context menu. From here, you can move a measure to one of
the pivot panels or to the modifiers axis, or assign a measure filter. Also, you can assign the marker type of a
chart point and its color.
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Filter panel
This statistical tool allows for easy selection on what data you want to see and what you don’t. You can apply
powerful filters to anything including hierarchy members, and measure values, thus leaving out the unimportant
data. You can sort the data to see, for example, the top 10 values and then you can gather the rest of the values
into a single group, so you only have what you really need.

The filtered elements (hierarchies and measures)
are automatically transferred to the Filter panel.
To assign a filter, you have to move an element
to the Filter panel. If the element hasn't been
filtered the appropriate visual filter editor will be
shown, similar to the one on the right:

In the Filter panel, you can call the Filtered Element Editor individually for each element.

Working Area
The OLAP-slice data is displayed in working area. In its upper part there is a menu for the quick access to the
frequently used commands². The rest is occupied by the current OLAP-slice and consists of the following parts Cube Axis headers, Cube Axes, Data Axes, Data Axis headers, Chart Panes.
You can change the view of the slice by relocating measures and hierarchies within the environment panel. When
you start dragging an element, all the possible locations, where it can be dropped to, will be highlighted. Most
elements have context menus that duplicate the mouse actions and provide additional control functions for
managing the slices' view.

Page

156

Grid working area
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Chart working area
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7.2 Working with the OLAP grid
The OLAP Grid view is comprised of a multi-dimensional table with expandable nodes. These nodes group and display data
according to the hierarchies used to define the measures and dimensions upon which the underlying data has been organized.
In tandem with the OLAP Chart view, the OLAP Grid view provides an ideal means of clearly conveying data to the user. It is
highly navigable and quickly provides detailed information to the user. The speed with which data recall occurs and the strong
formatting the grid enforces ensure data is always presentable and easily understandable. Consequently, OLAP Grid views can
easily be ported to spreadsheet applications for report compilation purposes.
Additionally, the OLAP Grid view allows users to effortlessly add and remove categories, filter and sort categories, and drill up
or drill down on data using powerful built-in menus. One of the greatest benefits this affords is that it allows users to explore,
navigate and refine data until the desired snapshot is achieved. Once in place this snapshot can then be reflected in a
complementary chart. This is possible as OLAP operations in Grid view can be synchronized with Chart view. These two data
views can then be deployed side-by-side or on top of one another.
Unicode support.
Simultaneous display of several different measures in the Grid.
Simultaneous drilling down based on different parameters: up to the nearest child, up to the next level, up to the next
hierarchy.
Saving and restoring the current OLAP-slice.
Hierarchy members grouping (including multilevel and parent-child hierarchies).
Separate sorting on different hierarchy levels. Possibility to override any sorting method.
Ascending or descending sorting based on the cell values in any column of the Grid.
Filtering of hierarchy members with or without applying these filters to the OLAP calculations.
Auto filtering of the hierarchy members depending on their values in the Grid. Major/minor members selection, either
based on their rank or on the Pareto principle.
Replacing hierarchy members by drag-n-dropping them within the Grid.
Auto sizing of cells depending on their contents.
Flexible export to MS Excel, HTML, GIF, JPG, PNG, BMP, CSV, TXT, PDF formats.
Operating the OLAP-slice
The OLAP-slice data are displayed in a table, whose appearance may be amended to some extent. For operating the current
OLAP-slice there are the following functions available:
1.
2.
3.
4.
5.
6.
7.

Navigation
Selecting and copying data
Drilling, sorting and moving hierarchy members
Operating context menus
Filtering data
Editing data
Setting the column width

1. Navigation - You can easily navigate the data using the keyboard:
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Button
Home
End
PageUp
PageDown
Ctrl+Home
Ctlr+End
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Action
Move to the first cell of the row
Move to the last cell of the row
Move one page up
Move one page down
Move to the top left cell
Move to the bottom right cell

Using the mouse, you can scroll the table up and down.
Mouse Action
Scrolling the mouse wheel

Component Action
Vertical scrolling of the table

Scrolling the mouse wheel with the Shift button held
down

Horizontal scrolling of the table

2. Selecting and copying data - The data area in the component can be selected like everything else in Windows:
•
•
•

Select all the cells pressing Ctrl+A;
Capture the area with the mouse;
Change the boundaries of the selected area with direction buttons, holding down the Shift button.

You can copy the data from the selected area to the clipboard by pressing Ctrl+C. If there’s no selection, pressing these buttons will
copy the whole OLAP-slice to the clipboard.
3. Drilling, sorting and moving hierarchy members - To
perform the drilling of the hierarchy members press
buttons on the Grid cells. If there’s only one drilling
button in a cell, then, instead of pressing it, you can
double-click the cell itself. By default, the drilling
buttons are shown only in the cells under mouse. To see
all the buttons, press the Ctrl button. The last cells in
the column area of the hierarchy members allow
showing the sorting direction. A pointer that indicates
the descending order of data illustrates it. You can
manage the sorting modes by single clicking on the cells
of the specified area: they are changed cyclically
[descending sorting] -> [ascending sorting] -> [no
sorting].
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4. Operating context menus -The context menu,
called by right clicking a table cell, partly duplicates
the OLAP-slice control functions.
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Hierarchy levels' menu

The view of context menu of the hierarchy levels' area. There is a list of commands available in the context menu of the hierarchy
levels’ area:
Command
Show totals first
Show totals last
Don’t show totals
Default sorting
Sort ascending
Sort descending
Aggregate all hierarchy
members
Aggregate visible members only
Drill all down\ to the next
hierarchy
Drill all down\ to the next level
Drill all down\ to the same-level
children
Drill all up
Clear filter
Filter on captions
Show empty cells
Create new group …
Copy selection
Conditional formatting

Function
Show the aggregated cells before all the rest
Show the aggregated cells after all the rest
Do not show the aggregated cells
Range hierarchy members by default
Range the hierarchy members by values from the bottom to the
top
Range the hierarchy members by values from the top to the
bottom
Aggregate all the hierarchy members (including hidden)
Aggregate the visible hierarchy members only
Drill all down to the next hierarchy
Drill all down to the next level
Drill all down to the same-level children
Collapse all the elements of this level
Remove any applied filters
Set the filter for measures
Show the cells with no aggregated values
Create a new group. It will appear at the first level of the
hierarchy
Copy the selected area to clipboard
Show the Conditional formatting menu

Hierarchy members' menu
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The view of the context menu of the hierarchy members' area
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Command
Drill down to the next
hierarchy

Function
Open the node up to the next hierarchy in the current area, ignoring
all the lower levels of the current hierarchy

Hide this member
Hide all members except
this
Hide all members above
this
Hide all members below
this
Show only the top

Show only the bottom

Filter on captions
Create new group..
Copy selection
Conditional formatting

Hide the member
Hide all the members of the hierarchy, except the selected one
Hide all the members of the hierarchy above the selected one
Hide all the members of the hierarchy below the selected one
Show the top elements of the level. Their number is specified in the
sub-menu. If you specify a percent value there, then the picking of
members will be such that their total value does not exceed the one,
specified in the sub-menu.
You can choose a threshold value from those offered in the
appropriate menu item or set your own one, selecting Other from the
menu.
Show the bottom elements of the level. Their number is specified in
the sub-menu. If you specify a percent value there, then the picking of
members will be such that their total value does not exceed the one,
specified in the sub-menu.
You can choose a threshold value from those offered in the
appropriate menu item or set your own one, selecting Other from the
menu.
Set the filter for measures
Create a new group on the current level
Copy the selected area to clipboard
Show the Conditional formatting menu

The menu for groups of hierarchy members
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The context menu that appears above the group cell.
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Command
Hide this member
Hide all members except this
Hide all members above this

Function
Hide the selected member
Hide all the hierarchy members except the selected one
Hide all the hierarchy members above the selected one

Hide all members below this
Show only the top

Show only the bottom

Filter on captions
Create new group
Delete this group
Clear this group
Rename this group
Copy selection
Conditional formatting

Hide all the hierarchy members below the selected one
Show the top elements of the level. Their number is specified
in the sub-menu. If you specify a percent value there, then the
picking of members will be such that their total value does not
exceed the one, specified in the sub-menu.
You can choose a threshold value from those offered in the
appropriate menu item or set your own one, selecting Other
from the menu.
Show the bottom elements of the level. Their number is
specified in the sub-menu. If you specify a percent value there,
then the picking of members will be such that their total value
does not exceed the one, specified in the sub-menu.
You can choose a threshold value from those offered in the
appropriate menu item or set your own one, selecting Other
from the menu.
Set the filter for measures
Create a new group
Delete the selected group
Clear the selected group
Rename the selected group
Copy the selected area to clipboard
Show conditional formatting menu
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Measure values' menu
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The context menu that appears above the group cell:
Command
Function
Sort ascending
Range the cells in the column by values from the
bottom to the top
Sort descending
Range the cells in the column by values from the top
to the bottom
No sorting
Remove any sorting
Filter on captions
Set the filter for measures
Hide this measures
Hide the selected measure
Show as
Specify the display mode of the current measure in
the Grid:
default
percent aggregated value in the row
percent parent element of the row
percent parent element of the column
percent total aggregated value

Copy selection
Conditional formatting

Copy the selected area to clipboard
Show conditional formatting menu

5. Filtering data - The filtered elements (hierarchies or measures) are automatically placed on the filters' panel. To start filtering,
move the element to the filters' panel. In case the element has not been filtered, the appropriate editor will launch (the Hierarchy
Editor for hierarchies and the Measure Filter Editor for measures). In the filters' panel, you can launch an editor for each element
independently.
The buttons for launching the editor ( ) are placed on the
panels in the Hierarchy levels’ area. If the button looks like
this ( ), it means the hierarchy had hidden members inside.
Pressing the button starts the Hierarchy editor.
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6. Setting the columns' width - You can change the width of columns in the data display area by dragging the right boundary with
the mouse. If possible, these changes will be saved during other operations with the table (like drilling, sorting, etc.) To return to the
original width, double click the right boundary of the column where it is visible. In case there were such changes in the table that
saving the assigned width of the columns was impossible (for example, if as a result of the Collapse drilling, the column with the
assigned width has disappeared), it will be set automatically. Unfortunately, if you operate a big table, calculating the columns’
width takes up too much time. That is why if there are more than 10, 000 cells in your table, their width will be set to default, but it
can be corrected later.
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7.3 Working with OLAP Chart
While the Grid view allows working with numbers, chart view allows representing your helpdesk data graphically. This gives
you and other managers a unique opportunity to analyze helpdesk data visually, dealing with charts rather than numbers,
which is much easier to perceive. Now it’s easier than ever to spot new trends and discover unknown problems in your data
flow. The statistical tool will help you gain an insight into your data and make new discoveries.

Tools panel
This panel houses all the frequently used operations on the OLAP chart - save, export, print and display options.
Button

Function
Load the Grid state
Save the Grid state
Export OLAP-slice data
Print OLAP-slice data
Preview
Undo
Redo
Switch axes
Select the docking panels layout
Set the scale of Chart display
Select the color palette for measures
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Modifier panel
Modificators are easy and powerful means of data representation. You can choose your data be shown in different colors, using
different shapes and sizes, so that you can easy distinguish them in a single graph. You can simply place a dimension or a measure on
a modificator’s pane and get the graph showing different values in a different manner.
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For example, you might place the "Problem Category" dimension on Color pane and get the Chart showing problem categories in
different colors. Or you can place the "Cost" measure on Color pane to highlight the top rates of supporting the service requests. The
same can be done for Shape and Size so that you can make your data perfectly distinguished.
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The layout of panels and hierarchies on the Modifier panel allows you to change the appearance of the displayed slice. When an
element is placed to the modifier panel (except for Details), its legend will contain the display parameters. If you modify the color
and shape of an element, the appropriate parameters can be amended.
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Modifier

The changes made upon placing a Chart element to the modifier area of...
a measure
a hierarchy
The color of the Chart elements will be
Hierarchy members will be painted with
chosen from the standard set of gradient
the colors from the current palette
colors

Color

The elements with the minimal value will
be painted with the first of the gradient
colors, and the elements with the
maximal value - with the last one

N/A

Size

Depending on the value of the measure
the size of the Chart points will vary
from the minimal to the maximal.

Hierarchy members will differ in size

Shape

Forbidden

Details

Forbidden

Hierarchy members will differ in shape.
If the number of hierarchy members will
exceed the number of available shapes,
some of them will be used more than
once
The panels will display series for all
hierarchy members

If a measure is placed on the Color pane, its values range is mapped to the given colors range so that it’s tremendously easy to spot
the top/low values. If you select the discrete gradient type, you'll be able to set threshold values for filling the Chart elements. While
the continuous gradient will let you evaluate the trend as a whole. To select the gradient type and tune its content, turn to the
legend panel.

The Legend panel
The panel contains descriptions of the modified elements.
The value, shape and color of a legend element can be
edited.
Setting the Color legend
To select a color, simply double-click the appropriate element
and choose a color from the pop-up editor.

Setting the Gradient legend
To edit the gradient, double-click the element and tune the settings in the
editor. In the Gradient Editor there are:
•
•
•
•

a set of pre-made gradients;
selecting gradient option (continuous or discrete);
creating a gradient with a set number of intermediate colors option;
setting threshold in per cent and measure values option;

Selecting threshold color option.
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Setting the Shape legend
The shape selection is made through the context menu. This
option is available only for points or lines Charts. If the
number of hierarchy members exceeds the number of
available shapes, they will be repeated.
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Chart Panes
The bulk of the OLAP-slice data are placed into cells with Charts. Each measure group has its own set of panes.

Measure groups with corresponding Charts in the working area
Chart Type
In the upper left part of each Chart, there will appear a
context menu for selecting its type. There are six (6) charts
that you can use, namely, Point Chart, Histogram, Point
Shape Selection, Lines, Curved lines and Step lines. By default,
the Histogram is used.
The size of Charts can be changed to some extent. To expand
a Chart along either one of the axes, you need to capture its
boundary with the mouse and drag it. You can change the
size along both axes (and return to default) through the tool
menu in the upper part of the working area.
Chart type menu

Hot keys for changing the scale
Ctrl+*
Reset Scale to 1:1
Ctrl+Num+
Zoom In
Ctrl+NumZoom Out
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Navigation
If the content of the Grid exceeds the client area, the scroll bars will appear. You can scroll down the data using the mouse wheel. To
scroll the Grid in the vertical direction, turn the mouse wheel, while holding Shift.

Back to TOC

Selecting Data
You can select Chart points with the standard Windows' method. Holding down the Ctrl button, you can add selected points,
holding down the Shift button, you can select the horizontal range. You can filter the Grid's points while selecting. In that
case, the corresponding hierarchy members will be filtered automatically.
Selecting and filtering parts of Charts
a. Selecting some of the Chart points

b. Selecting the Filter command
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c. The result
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Note: When moving the mouse cursor over a data axis, you are able to select a continuous range of members (if the axis is
composed of them) or a range of values in Charts.

Filtering hierarchies
In case you need to collect data not from the whole Grid, but just from a part of it, the component has a few functions at your
disposal: they let you select or remove elements from the slice. Also, there is a standard option of exporting data into a
number of formats and printing out the content of OLAP-slices. The simplest way of selecting data is through the context
menu. When you click a hierarchy member on the Cube axis, there is a set of commands for quick operations with members:
•
•
•
•

Hide this member
Hide all members except this
Hide all members above this
Hide all members below this

Filter on hierarchy level
The Filter area of the Editor becomes visible only in case if filtering by hierarchy levels is available. To apply a filter to hierarchy
members, you need to select a hierarchy level (if there's more than one) and assign the Filter condition in the Filter menu. In the
same menu, there's a command to clear filter.
Filtering hierarchy members
If the search field is not empty, the "Find" command will make the component perform a search for hierarchy members, whose
levels contain the specified string. You can narrow the search results by checking the "Exact matching" box.
Filtering a single member of a hierarchy
By default, the Editor is able to select any number of hierarchy members. To switch to the single-select mode, uncheck the
"Multiselect" box. In that case, only one the hierarchy member with all its parents and members will be selected.
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Filtering measures
There is a number of available parameters for filtering measures. In the same Editor, you can clear the filter.
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7.4 Predefined Reports
Predefined reports allow helpdesk managers and technicians to quickly and
easily retrieve information for common inquiries. Reports play a vital role as
far as a Help Desk product is concerned. Requests that are open, closed or
overdue at any instant of time, which person or department is sending the
most number of requests & who is attending to the requests can all be known
from the readymade reports available with the statistical tool. Each predefined report works in both OLAP grid and OLAP chart view.
There are several predefined reports in each of the report categories, and
each report is run directly on a mouse-click from the tree view. Around 40
reports are made available for instant details about the help desk activities.
Any of the predefined reports can be also be edited so you can customize the
report to return specific results:
•
•
•
•
•
•

Reports by Assets
Reports by Cases
Reports by Callers
Reports by Date/Time
Reports by Problems
Reports by technicians

All these categories have reports available based on Department, Priority,
Requester, Technician, Category and Request Date.

Some sample OLAP charts of the predefined reports
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A) Time spent on Asset
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B) Cases Count by Origin
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C) Average time spent on caller

D) Due date

E) Cost per problem category

F) Time spent by technician

7.4 Printing, exporting statistical data and charts
Now that you have successfully designed a report, you might want to save it for future reference or share it with others.
Reuse your work! You can now save data snapshots to HTML, BMP, CSV, GIF, HTML, JPEG, PDF, PNG, TIFF, TXT, XLS and XML
as a simple way of reusing your data for documents and spreadsheets. Depending on the active view (Grid or Chat), the saved
file would either take the grid data or the chart.

Available export formats in Chart View

Available export formats in Grid View
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Printing
You can print your report to share it with others using the built-in Print Preview window. You can tune your page/printer settings
before printing. Also, if you feel like sharing the report through the net or by email you can easy export it to a wide range of formats
including PDF, XLS, CSV, JPG, etc.
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Export Settings -This tool allows you to customize the appearance of the reports to be printed or saved to a file format. You can
specify the page size, orientation, headers & footers and color of the fonts and page background.
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8. Contact Manager
The Contact Manager is a consolidated view of all available contacts in the caller and technician lists, listing the email address,
mobile and phone numbers. A quick correspondence can be initiated to a particular contact in a single click via email, SMS or
phone call.

Compose an email with the contact email address already populated in a new email inspector window.

Allows you to choose a knowledge base article and then insert it on a new email with the contact email address
already populated.

Allows you to choose a FAQ answer and then insert it on a new email with the contact email address
already populated.

Compose a SMS message to send it to the mobile number of the contact.

Make a call (either Skype or attached phone) directly to the mobile number of the contact.
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Make a call (either Skype of attached phone) directly to the telephone number of the contact.
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9. Archive Cases
Over time, as the number of cases and emails in Team Helpdesk folders build up, the size of the folders and mailbox increases too.
And one pitfall with Outlook having folders/mailboxes with thousands of case items/emails is the sluggish performance you will
perceive in its normal operation.
For instance, if the resolved cases contain thousands of old cases, and assuming there are other thousands of associated emails in
the Team Helpdesk History folders, when you try to open an existing case, it may take longer to load and show the form and the
fields. This is because Team Helpdesk scans your resolved cases folder for those cases that are related to the opened case (in terms
of the caller, asset or company). And this scanning process will take time if you have thousands of cases and emails in the Team
Helpdesk folders. Therefore, archiving old cases (say older than 30 days) and their associated emails out of Team Helpdesk folders
(i.e., to a PST or another mailbox or public folder) would greatly help reduce the scanning/probing time thereby increasing
responsiveness and performance of Outlook and Team Helpdesk.
Two modes of archiving old, resolved cases are supported:
a) Archive cases to a PST
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b) Archive cases to another Shared mailbox or Public folder.
This is the recommended way of archiving as it overcomes the limitation with using a PST data file (which is, PST file can't be
accessed and opened simultaneously by more than one person in their Outlook even if the PST file is shared on a network folder).
Further, with this technique, the archived cases are searchable from Team Helpdesk and could be included in Summary Reports and
OLAP Statistics too. And when a reply to an archived case is received, Team Helpdesk would automatically add that email to that
case and re-opens it (i.e., the case would be un-archived and moved to the Ongoing Cases automatically). Moreover, only on this
option, you can enable the auto archiving feature where the Team Helpdesk Manager add-in would scan for old resolved cases and
their emails for archiving. You can define the number of days old/resolved cases that are to be kept in the Team Helpdesk > Resolved
Cases folder before they are moved to the archived folder.
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In both options, emails associated with the cases are also archived. At any time, you can retrieve back the archived cases from the
'Retrieve archived cases/emails' (second) tab. You can either display all the archived cases or apply a filter search using keywords or
by technicians or problems. And choose those particular cases that you want to retrieve back to the resolved cases (or re-open them
to the Ongoing Cases folder).
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10. Uninstalling Team Helpdesk Manager SP add-in
To uninstall the Team Helpdesk Manager SP add-in from your computer, follow the steps outlined below:
Step 1: Go to ‘Control Panel > Programs and Features’. Scroll down to select ‘Team Helpdesk Manager SP (x86) or (x64)’ and
click ‘Uninstall’ as illustrated below:

Step 2: A dialog confirmation follows asking for confirmation. Click Yes.

Step 3: The Team Helpdesk setup will now start the un-installation process. Make sure that Microsoft Outlook is not running (even
under the task manager).
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Step 4: After the add-in uninstallation is successful, you can start Outlook and delete the ‘Team Helpdesk SP’ folder that was created
under your Exchange mailbox or Public Folder.
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11. Important links
Team Helpdesk for Outlook and SharePoint - Home page
Go to the official website of Team Helpdesk for Outlook and SharePoint.
Video Tutorial clips
Watch video tutorials that teach you how to install, configure and work with Team Helpdesk.
Purchase License
Purchase an enterprise team license for Team Helpdesk for Outlook and SharePoint.
Knowledgebase articles
Looking for an in-depth understanding of this application? Browse through a series of knowledge base articles
on Team Helpdesk online.
Support Maintenance contract
At AssistMyTeam, we're committed to give you the best support for all the products that we offer and more!
The AssistMyteam Support Contract helps you use our products more efficiently and work out any issues that
you encounter during the course of their use.
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Submit an online support ticket
Use this web form to create a ticket with AssistMyTeam Technical Support.
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